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SYMANTEC LICENSE AND WARRANTY
The software which accompanies this license (the "Software") is the prop-
erty of Symantec or its licensors and is protected by copyright law. While 
Symantec continues to own the Software, you will have certain rights to use 
the Software after your acceptance of this license. Except as may be modi-
fied by a license addendum which accompanies this license, your rights and 
obligations with respect to the use of this Software are as follows: 

¥ You may: 

(i) use one copy of the Software on a single computer; 

(ii) make one copy of the Software for archival purposes, or copy the 
software onto the hard disk of your computer and retain the original for ar-
chival purposes;

(iii) use the Software on a network, provided that you have a licensed 
copy of the Software for each computer that can access the Software over 
that network;  

(iv) after written notice to Symantec, transfer the Software on a per-
manent basis to another person or entity, provided that you retain no copies 
of the Software and the transferee agrees to the terms of this agreement; 
and 

(v) if a single person uses the computer on which the Software is in-
stalled at least 80% of the time, then after returning the completed product 
registration card which accompanies the Software, that person may also use 
the Software on a single home computer.  

¥ You may not:

(i) copy the documentation which accompanies the Software;

(ii) sublicense, rent or lease any portion of the Software;

(iii) reverse engineer, decompile, disassemble, modify, translate, 
make any attempt to discover the source code of the Software, or create de-
rivative works from the Software; or

(iv) use a previous version or copy of the Software after you have re-
ceived a disk replacement set or an upgraded version as a replacement of 
the prior version, unless you donate a previous version of an upgraded ver-
sion to a charity of your choice, and such charity agrees in writing that it will 
be the sole end user of the product, and that it will abide by the terms of 
this agreement. Unless you so donate a previous version of an upgraded 
version, upon upgrading the Software, all copies of the prior version must 
be destroyed.

¥ Sixty Day Money Back Guarantee:

If you are the original licensee of this copy of the Software and are dissat-
isfied with it for any reason, you may return the complete product, together 
with your receipt, to Symantec or an authorized dealer, postage prepaid, for 
a full refund at any time during the sixty day period following the delivery 
to you of the Software.

¥ Limited Warranty:

Symantec warrants that the media on which the Software is distributed will 
be free from defects for a period of sixty (60) days from the date of delivery 
of the Software to you. Your sole remedy in the event of a breach of this 
warranty will be that Symantec will, at its option, replace any defective me-
dia returned to Symantec within the warranty period or refund the money 
you paid for the Software. Symantec does not warrant that the Software will 
meet your requirements or that operation of the Software will be uninter-
rupted or that the Software will be error-free. 

THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF 
ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY, FITNESS FOR A PARTICULAR PURPOSE AND NONIN-
FRINGEMENT.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM 
STATE TO STATE.

¥ Disclaimer of Damages:

REGARDLESS OF WHETHER ANY REMEDY SET FORTH HERE-
IN FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT WILL SY-
MANTEC BE LIABLE TO YOU FOR ANY SPECIAL, 
CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, IN-
CLUDING ANY LOST PROFITS OR LOST DATA ARISING OUT 
OF THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF 
SYMANTEC HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLU-
SION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY 
NOT APPLY TO YOU.

IN NO CASE SHALL SYMANTECÕS LIABILITY EXCEED THE 
PURCHASE PRICE FOR THE SOFTWARE. The disclaimers and limi-
tations set forth above will apply regardless of whether you accept the Soft-
ware.

¥ U.S. Government Restricted Rights:

RESTRICTED RIGHTS LEGEND. Use, duplication, or disclosure by the 
Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) 
of the Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or subparagraphs (c) (1) and (2) of the Commercial Comput-
er Software-Restricted Rights clause at 48 CFR 52.227-19, as applicable, Sy-
mantec Corporation, 10201 Torre Avenue, Cupertino, CA 95014.

¥ General:

This Agreement will be governed by the laws of the State of California. This 
Agreement may only be modified by a license addendum which accompa-
nies this license or by a written document which has been signed by both 
you and Symantec. Should you have any questions concerning this Agree-
ment, or if you desire to contact Symantec for any reason, please write: 

Symantec Customer Service, 175 W. Broadway, 

Eugene, OR 97401.
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What’s new in Visual Page

The 2.0 release adds enhancements to the functionality and usability of 
Visual Page. This section describes these exciting features.

Please refer to the Visual Page README.TXT Þle for late-breaking product 
information.

Cascading style sheets

You can standardize your Web site and its content by creating and 
implementing cascading styles sheets, or CSS. The Visual Page UserÕs 
Guide refers to CSS as style sheets. For more information on working with 
style sheets, see ÒFormatting tags and pages with style sheetsÓ on page 3-
12. You must have a CSS-enabled browser to view your work outside of 
Visual Page.

Layers

Add sophistication and style to your Web site by desiging and adding 
layers (also known as absolute pixel positioning) to your Web pages. 
Visual Page allows you to visually create and deÞne most properties for 
layers. To work with layers, see Chapter 5, ÒWorking with objects.Ó

Project Management

Visual PageÕs Project Manager helps you keep your Web site up to date 
with powerful project and site management features:

n Project Wizard

The Project Wizard gets you started in creating a new Web site or 
work with an existing one.
What’s new 1
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n One-touch publishing

Publishing your project to your remote Web site is done with the 
click of the Publish button. For more information, see ÒPublishing 
your projectÓ on page 8-11,

n Automatic checking and updating of all links and anchors

The Project Manager automatically updates and manages all kinds of 
links within your project as you work.

n Global spell checking and Find and Replace

Work with one Web page or an entire site. For more information, see 
ÒChecking spelling in a projectÓ on page 8-5 and ÒFinding and 
ReplacingÓ on page 8-6.

n Enhanced Source Editor features

You can change the font, font size, and colors in the Source Editor.

Previewing in multiple browsers

You conÞgure your favorite Web browsers in Visual Page to immediately 
see the results of your work. You wonÕt need to leave Visual Page to start a 
Web browser, Þnd the page and load it. Then, you can switch to any other 
conÞgured browser at any time. This feature comes in handy when 
working with browser-speciÞc implementations of cascading style sheets 
and layers.
What’s new 2



           
C    H    A    P    T     E     R 1
Welcome to Visual Page

Visual Page is a complete tool for creating, managing, editing and 
publishing documents for the World Wide Web. ItÕs a visual-based designer, 
source code editor, and publishing utility, together in one package. You 
can use Visual Page to create all types of content, from one Web page to 
complex Web sites containing hundreds of pages.

This chapter provides a summary of the basic features of Visual Page, 
along with the system requirements of Visual Page; descriptions of the 
contents of this book and other Visual Page documentation; and an 
overview of Internet concepts.

About Visual Page
SymantecÕs Visual Page is the fastest, easiest-to-use, what-you-see-is-what-
you-get (WYSIWYG) Web design software available on the market today. 
You can use Visual Page to bring dynamic and colorful Web pages to life 
without having to learn Hypertext Markup Language (HTML) formatting 
tags. Visual Page is as easy to use as your favorite word processor, yet has 
tools that are sophisticated enough to satisfy the most demanding user. 

Features
Unlike most other HTML-based Web page editors, Visual Page displays 
your Web page so you see it as itÕs created. Visual PageÕs easy-to-use main 
editing window lets you create pages quickly, similar to creating 
documents in a basic word processor. You can drag and drop blocks of 
text, graphics, and other Web-based media onto a Web page, and Visual 
Page creates the necessary HTML code for you. 
1-1
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Project-based site management tools

When you work with a Web site in Visual Page, you work with projects to 
keep your site (and yourself!) organized. Projects keep track of all the 
relational information between the Þles in your Web site, such as changed 
links and changed images.

In addition to its sophisticated layout tools, Visual Page includes several 
Web site management tools. With Visual Page, you can create your Web 
site as a project on your local hard drive, and then publish the entire 
project to a Web server, without ever leaving Visual Page. No third party 
utility packages are necessary. When you need to perform routine 
maintenance on your Web site (for example, deleting unneeded Þles and 
Þxing broken links), you can do that within Visual Page as well.

Visual Page is also a useful tool for testing the links between pages in your 
site. Use the Project Manager to take inventory of new Web sites that you 
acquire. Using Visual PageÕs Project Manager, links and anchors are 
maintained for you by the Project Manager.

Extensive HTML authoring tools

Visual Page doesnÕt require that you enter complex HTML code Ñ entering 
and modifying content is quick and easy. Advanced Web design elements 
are easily created and edited as well Ñ for example, tables and frames can 
be inserted and manipulated with a minimum of steps, and without HTML 
coding.

If you prefer to directly control your HTML code, you can view and edit 
the HTML code generated by Visual Page in the Source Editor. Changes 
made in the Source Editor are automatically reßected in the main editing 
window, allowing for seamless navigation between the source and visual 
(main window) editor.

State-of-the-art media support

Visual Page offers a wide range of advanced Web media tools. Frames, 
tables, QuickTime movies, Navigator plugins, Java applets, JavaScript code 
and CGI-based forms can all be inserted effortlessly into your Web pages. 

In addition, Visual Page 2.0 supports cascading style sheets (CSS) and 
layers. Use the Style Sheet Editor and Layer Editor to add style and 
consistency to your Web site.
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Extensive template and sample set

The Visual Page DesignerÕs Toolkit consists of a number of templates and 
sample documents. The templates cover a wide range of document styles, 
and the samples cover a number of document types (such as product plans 
and registration forms). These templates can be used as the basis for your 
business or personal Web sites, saving you hours of design time in the 
process.

Updating Visual Page

Visual Page is equipped with a feature called LiveUpdate. Using 
LiveUpdate, you can access newer versions of the software as they become 
available. 

If your computer has a modem or an Internet connection, you can 
download Visual Page updates and additional product information using 
LiveUpdate. To receive an update, choose LiveUpdate from the Help 
menu, then follow the directions as they are presented.

System requirements

Visual Page's minimum system requirements are as follows:

n 80486 or higher, 66 Mhz minimum

n 8 megabytes of random access memory (RAM) minimum (12 
megabytes for Windows NT)

n 20 megabytes free hard disk space

n VGA card (Super VGA recommended)

n 256 or more colors (necessary for Java performance)

n Windows95/NT 4.0 installed

n CD-ROM drive

Note: In addition to the above system requirements, it is recommended 
that you have an Internet Service Provider (ISP) account and Web server 
account (included with most ISP accounts), in order to access and publish 
your Web site to the Web.
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Visual Page’s documentation

Visual Page comes with a complete set of documentation and online help 
to assist you in the process of learning Visual Page. These documents are 
described below.

Getting Started Guide

The Getting Started Guide consists of installation instructions for Visual 
Page, and a Tour of Visual Page. The Tour is designed to familiarize you 
with the main features of Visual Page by guiding you through the process 
of building a working Web page. It requires no previous experience in 
Web page development. 

In the process of completing the Tour, youÕll learn to use many of Visual 
PageÕs features, from creating a basic Web page to designing an entire Web 
site. The Tour is the quick way to learn Visual Page Ñ and itÕs fun!

User’s Guide

This may be the document you turn to most frequently as you work with 
Visual Page, as it contains step-by-step information on using Visual PageÕs 
features. 

The chapters in this guide cover general topics involved with creating Web 
pages, such as text and graphics formatting, advanced Web features, site 
publishing, and site maintenance and management. The table of contents 
at the beginning of this guide lists the contents of these chapters, and the 
major subsections in each chapter. The glossary covers commonly used 
Web-related terms, and the index lists the contents of this guide by 
alphabetical index entry.

Online Help

Visual Page has an extensive help system, providing all of the procedures 
for building a Web page. To access Visual PageÕs help, select Help Topics 
from the Help menu. From dialog boxes, toolbars, and windows, you can 
press F1 to access Help that is speciÞc to your current Visual Page activity.
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Web basics
The foundation of accessing online media is a global set of interconnected 
computers called the Internet. Similar to the network you may use at work 
or school, but on a larger scale, the Internet is the ÒglueÓ used to connect 
computers together. 

Though it has been in use for over thirty years, the Internet became 
popular only recently, due to the graphics-based front end of the Internet: 
the World Wide Web (otherwise known as the Web). Unlike the Internet 
tools that preceded it, the Web allows easy access to information on the 
Internet Ñ so easy that people with little or no background with using 
computers can view text, graphics, and other forms of media through it. 

This section covers the basics of the Web and the common vocabulary 
associated with it, including the protocols used to format, save, upload and 
download Web-based media.

Publishing on the Web

One of the strongest potentials of the Web is its direct and easily 
implemented publishing abilities Ñ it is possible to design an entire Web 
site in weeks (or even days) and place it up on the Web. Visual Page is 
designed to complement and expedite this process, via its wide range of 
visual tools. 

The components of Web-based publishing with Visual Page are:

n Web pages

n Web sites

n HTML (Hypertext Markup Language) formats

n Publishing Þles to a Web server

What are Web pages?

A Web page is a type of document, viewed in a Web browser. You use 
Visual Page to construct documents for the Web, more commonly known 
as Web pages. You can work entirely in Visual PageÕs Visual Editor, taking 
advantage of drag-and-drop, or work in the Source Editor with its own 
features to make your source code manageable. You can even work easily 
with a combination of the two!
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An example of a Web page is the main page for SymantecÕs local template 
Þles (located in the Templates subdirectory in your Visual Page directory 
on your computer):

For more information in creating Web pages, see Chapter 2, ÒCreating Web 
pages.Ó If you want more information on creating and working with 
projects, see Chapter 8, ÒCreating and managing Web sites.Ó

What is a Web site?

A Web site is a collection of Web pages, linked together to create a 
cohesive collection of information. 

A Web site typically is accessed via its home page. The home page may 
contain a topic list which links it to other Web pages within the Web site, 
as well as pages within other Web sites. The home page is usually named 
index.html, although some Web sites name their home page 
default.html or home.html.

Visual Page keeps your Web site together with a project Þle. Project Þles 
have the .vpp extension, and contain relational information about all the 
1-6
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Þles in your project. Even if you modify a Þle in a project without opening 
its parent project, Visual Page updates the corresponding project Þle.

The home page from SymantecÕs Visual Page Web site (located at http:/
/www.cafe.symantec.com) is shown below.

Web sites are typically accessed through a Web browser Ñ a software 
application expressly for viewing Web pages. As you can see, Visual Page 
can download Web pages, in addition to browser applications such as 
Netscape Navigator or Microsoft Internet Explorer. 

For information about managing a Web site, see ÒCreating and managing 
Web sitesÓ on page 8-1.

What are HTML tags and style sheets?

The formatting of a Web page is controlled by a collection of markup 
codes. These codes, called HTML tags, are used to create and control the 
display of your Web page.
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HTML tags mark off parts of a Web page to display it in a certain style. 
These tags are interpreted by your Web browser with information about 
how the Web page content should be displayed. You can see these tags by 
opening any Web page Þle (ending with the.html or .htm sufÞx) with a 
text editor, word processor, or within Visual Page. 

You can also standardize and enhance your Web pages with cascading 
style sheets (also called CSS, or style sheets). Like HTML, CSS has its own 
syntax and attributes. However, CSS groups its styles together and also 
allows you to redeÞne HTML tags.

Visual Page automatically generates HTML and CSS source code as you edit 
your Web page, interpreting the tags as you create them in the Visual 
EditorÑ no HTML or CSS coding is necessary for Web page creation. For 
more information about support of HTML tags in Visual Page, see 
ÒInserting text into a Web pageÓ on page 3-1 and ÒFormatting tags and 
pages with style sheetsÓ on page 3-12.

How do you publish projects?

When you publish your project to your Web site, you use a network 
protocol (a set of predeÞned commands) to place the Þles on a Web 
server Ñ a computer thatÕs dedicated to storing and sending out Web-
based Þles. The most common protocol used for transferring Þles to a Web 
server is the File Transfer Protocol (FTP). The Visual Page Project 
Manager uses FTP to upload projects and Þles from your system to a Web 
server, rather than having to enter FTP instructions at a command line. 
Visual Page Project Manager provides extensive FTP support, including the 
ability to publish projects, upload, download, rename, and delete server-
based Þles. For more information, see ÒPublishing your projectÓ on page 8-
11.

Using hypertext

One of the characteristics that distinguishes Web-based publishing from 
other forms of publishing is its ability to create access paths between 
documents. The mechanism for creating these paths is called hypertext. A 
hypertext document is made up of links to other documents, combined 
with its displayed content. These links can connect to text, pictures, sound, 
animation, Java applets, and video clips, as well as to other Web pages. 

On the Web, hypertext is implemented by the following types of Web-
based components:
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n Uniform Resource Locators (URLs)

n Links

n Anchors

What are URLs?

Visual Page uses the Uniform Resource Locator (URL) standard for 
determining where linked Þles are located. A URL consists of a type of 
address that locates a Web page on the Internet in response to a browser 
request.

A typical URL looks like this:

http://www.symantec.com/tools/docs/User%20Guide.html#topic1

A URL can consist of up to Þve parts:

Protocol. The rules governing the transfer of data over the network; 
the Internet uses http (the HyperText Transfer Protocol).

Domain. The host name and Internet namespace; for example, 
www.Symantec.com.

Directory path. The Þle's location on its server; for example, tools/
docs.

Filename. The Þlename being linked to; for example, 
User%20Guide.html. The %20 is the HTML formatting code for a 
space character.

Anchor. The anchor, preceded by a number sign (#), refers to a 
speciÞc location within a Web page, in this example, #topic1.

What are links?

Links allow you to connect other Þles to your Web pages. When a user 
clicks on a linked Þle, such as a piece of text, a graphic, or a portion of a 
graphic, their browser displays the Þle that the link points to. These Þles 
may be other Web pages, text, graphics or Web media (such as audio and 
video).

Links embedded within text are easily identiÞable. Most browsers default 
to coloring and underlining linked text, and users can set the color and 
underline options as they prefer. 
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A Web page with several links is shown below.

You can use the Site Manager to test and Þx all links in your Web site.For 
more information on creating and editing links with Visual Page, see 
ÒInserting linksÓ on page 4-1.

What are anchors?

Anchors are used to mark speciÞc locations within a document. Once an 
anchor is placed in a location, you can create a link to that spot. 

Link to 
another 
Web page
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A page with an anchor is shown below.

If you click on an object that is linked to an anchor in an external 
document, the document opens at the anchored location. Anchors that are 
within the same document as their target make the document scroll to the 
anchor's location. 

Visual Page represents anchors with an anchor icon, in both the Project 
w indow and in the Visual Page document in which they are placed. 
Anchors are inserted at the spot that you want to link to. Anchors arenÕt 
visible when in Preview mode nor when viewing a page through a Web 
browser.

For more information on creating and editing anchors with Visual Page, 
see ÒInserting anchorsÓ on page 4-3.

Designing for the Web

In the past few years, a variety of design enhancements have been added 
to the initial HTML speciÞcations, which was designed primarily for basic 
text formatting and display of static graphics.

Anchor
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Visual Page 2.0 supports:

n Cascading style sheets (CSS)

n Layers 

These new features allow you greater control over the design of your 
document, and incorporate an expanded set of media within your Web 
sites. 

What are style sheets?

Style sheets contain style deÞnitions that are applicable to one line only, 
or for all documents in your Web site. A style deÞnition is usually an HTML 
tag. You can create style deÞnitions based on existing HTML style 
deÞnitions, redeÞne HTML style tags, or create new ones.

For more information about cascading style sheets, see ÒFormatting tags 
and pages with style sheetsÓ on page 3-12.

What are layers?

Layers are objects that can be positioned at any pixel on your Web page. 
You can move them around, stack them, hide them, or change their colors 
and messages. You wonÕt need to write the code yourself for even the most 
complex objects; let the Layer Editor do it for you. For more information 
on layers, see ÒUnderstanding layersÓ on page 5-16.

Programming for the Web

Visual Page provides support for a wide variety of Web-based 
programming platforms, including:

n Java applets

n JavaScript

n Form-based scripts and applications

What are applets?

Visual Page supports the embedding of Java applets within Web pages. 
Java applets are interactive mini-applications (created with the Java 
programming language) contained within a Web page. Applets are useful if 
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you want to embed software programs (such as calendars or alarm clocks) 
within your pages. Use SymantecÕs Visual Cafe to create Java applets 
quickly and easily. 

Like other Þle types supported by Visual Page, applets can be dragged and 
dropped into any Web page. In addition, Visual Page provides a standard 
Java console window, for testing purposes.

For more information on applets, see ÒInserting appletsÓ on page 7-4.

What is JavaScript?

Netscape's JavaScript scripting language adds basic interactive 
functionality to HTML Ñ for example, it can provide users with dynamic 
control over your Web site's content. Visual Page allows you to include 
JavaScript code within your Web site, either by inserting JavaScript code 
within an HTML Þle, or by linking to the Þles containing JavaScript code 
from within an HTML Þle.

For more information on JavaScript, see ÒUsing JavaScriptÓ on page 7-7.

What are forms?

Forms let users pass information (such as their name and address) from 
their browser to a Web server. Forms commonly interface with Common 
Gateway Interface (CGI) applications, which are computer programs that 
process the information that a user enters into a form, and then send the 
information to the Web server.

Visual Page provides an extensive range of form creation tools, including 
drag-and-drop form elements, support of CGI scripts, and insertion of 
multiple forms within a single HTML document.

For more information on forms, see ÒCreating formsÓ on page 7-9.

What’s next
In the next chapter, we explore the essential features of Visual Page, 
including an overview of creating Web pages in Visual Page and 
information on setting Visual PageÕs global and document preferences.
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Creating Web pages

Visual Page provides a wide range of features to aid you in trouble-free 
creation of Web pages. Visual Page provides an easy yet sophisticated 
system to manage the collection of Þles that make up a project. A project is 
the primary component of Visual Page. For more information about 
working with projects, see ÒCreating and managing Web sitesÓ on page 8-1

This chapter describes the basic components of these various tools, 
creating Web pages, and how to control the document and global settings 
within Visual Page.

Launching Visual Page
Before you can use Visual Page, you need to install it on your computer. 
For installation instructions, see the Visual Page Getting Started Guide.

To launch Visual Page:

1 Click the Start button on the Taskbar. 

The Start menu appears.

2 Point to Programs. 

The Programs menu appears.
2-1



Chapter 2: Creating Web pages
3 Point to Symantec Visual Page, and select the Visual Page 
program:

Visual Page opens, with a new, untitled web page ready for editing.

Once youÕve launched Visual Page, the main editing window appears. The 
main editing window serves as the visual editor for Visual Page. If you 
want to open a project, see ÒOpening projectsÓ on page 2-6 for more 
information.

The Visual Page interface

One of Visual PageÕs strongest features is its intuitive yet powerful 
interface. Combining the best features of visual HTML editors and high-
level text-based Web authoring tools, the Visual Page interface allows you 
to create and manage Web-based content quickly and completely, without 
having to resort to third party tools. 
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The main component of the Visual Page interface is its main editing 
window, shown below.

Visual PageÕs toolbars provide access to the most commonly used features 
of Visual Page. The toolbars are the Òcentral hubÓ of Visual PageÕs main 
window Ñ most of your Web page formatting and project management 
can be done directly from it.

To view or hide a toolbar, choose Toolbars from the View menu. Select a 
toolbar that you wish to display, and deselect a toolbar that you wish to 
hide. You can also access this toolbar menu by right-clicking anywhere on 
a toolbar. You can also move toolbars around and place them anywhere 
within the Visual Page environment window.

To dock a toolbar, drag it to the main toolbar or to the bottom of the Visual 
Page window.

Toolbars

Edit 
area

Link To 
field
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Below are the main toolbar buttons:

Create 
a new 
project

Create 
a new 
page

Open 
file or 
project

Check 
spelling

Save file 
or 
project

Cut

Copy to 
Clipboard

Paste 
from 
Clipboard

Print

Preview 
in 
multiple 
browsers

Display 
source

Edit 
object 
properties

Edit 
Web 
page

Preview 
page

Edit page 
properties

Create 
link

Insert 
container

Insert 
image

Insert 
plugin

Insert 
anchor

Insert 
line

Insert 
Java 
applet

Insert 
table

Add row

Add 
column

Delete 
row

Delete 
column

Span 
selected 
cells
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Additional information on toolbar features can be found in the remaining 
chapters of this book.

Visual PageÕs editing area is where you add or delete the elements of your 
Web pages Ñ everything from text and graphics to tables and Java applets 
are placed here.

The Link To Þeld is used to create links Ñ connections from one Web page 
or Web element (such as a graphic or a sound clip) to another. For more 
information on creating links, see ÒInserting linksÓ on page 4-1.

Opening files
You can open Web pages in Visual Page in two ways:

n As an individual Web page

n As part of a project

When you close the Visual Page application, Visual Page remembers the 
last Þle or project that was open, and will open it automatically the next 
time you open Visual Page.

Opening Web pages

You can open previously saved Visual Page Web Þles and continue 
working on them at anytime, even with other Web Þles open.

Decrease 
text size

Increase 
text size

Bold

Italic

Text 
color

Align 
left

Align 
center

Align 
right

Decrease 
indent

Increase 
indent

Object 
alignment

Paragraph 
format

Font 
format

Font sizeText styles
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To open a Web page in Visual Page:

1 Select Open from the Visual Page File Menu. 

The Open dialog box displays.

2 Select the desired Þle type from the drop-down menu.

3 Navigate to the desired Web page.

4 Click Open. 

The Web Þle opens in Visual Page.

or:

To open a Web file by dragging the file icon from the Windows 
Explorer:

1 Open Visual Page.

2 Open the Windows Explorer. 

3 Arrange your Windows desktop area so that both the Visual Page 
and Windows Explorer windows are visible.

4 Using Windows Explorer, navigate to the desired Web Þle.

5 Select the desired Þle, and drag it to the Visual Page window. 

The Þle opens in Visual Page.

Opening projects

Projects keep your Web site organized by keeping everything together in a 
folder.

To open a project:

1 From the Project menu, select Open Project.

The Open Project dialog box appears.

2 Navigate to the desired project Þle.

3 Double-click the project Þle.

The Project window opens for the project.

To open a Web file from within a project:

1 Open the project that contains the Þle. See ÒOpening existing 
projectsÓ on page 8-4 for more information.

2 Navigate to the Web page you want to open.
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3 Double-click to open the Web page.

The Web page opens in the Visual Editor.

Once youÕve launched Visual Page, the main editing window appears, 
displaying an untitled Web page. The main editing window serves as the 
visual editor for Visual Page. This window is where youÕll do most of your 
Web page formatting and editing.

Note: If you open Web pages that are part of a project, the Project Þle is 
automatically updated with any changes you make. For more information 
on working with projects, see ÒCreating and managing Web sitesÓ on page 
8-1.

Setting preferences
When you start using Visual Page, you can set up a variety of preferences 
to customize the way you want to work. There are two groups of 
preferences within Visual Page: global preferences and page defaults. 
Global preferences affect how features are implemented in Visual Page, in 
all pages and projects. Page defaults apply to a single Web page, and they 
handle the primary elements of the Web pageÕs appearance, from text color 
to background images.

Setting global preferences

Global preferences control the functioning of a number of essential 
features within Visual Page, such as how Þles are used, how multiple 
viewers are conÞgured, page defaults, HTML generation, and how the view 
in the Source Editor is conÞgured. These global preferences are applied to 
each new project or page that you create.
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To set Visual Page’s global preferences:

1 From the Edit menu, select Preferences. 

The Preferences dialog box opens.

2 Select the tab for the category of preferences you want to set.

3 Select the desired option. The options for each category are 
described in the table below.

4 Click OK to save your preferences changes. 

The following table describes the categories of preferences available in the 
Preferences dialog box. An explanation of each preference option (within 
each category) is included.
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Preference tab Description of preference options

General Sets miscellaneous attributes, including the 
following:

¥ Support new browser features 
(cascading style sheets and layers

¥ Automatically re-load changed 
HTML Þles

¥ Save Workspace
¥ Attributes list in Style Sheet dialog 

is editable
¥ Insert an invisible character into 

new table cells (Browsers donÕt 
display the cell border on the 
background color for empty cells)

¥ Run Java applets in Preview mode.

Viewers Sets browsers to view the items in your site or 
project.

¥ Set default browser for previewing 
of  your work

¥ Add another browser for 
previewing of  your work

¥ Remove deletes the conÞgured 
viewer

¥ Advanced
¥ Clear removes all 
¥ Revert

Page Defaults Sets various page defaults, such as background 
images, as well as colors for:

¥ Background
¥ Normal Text
¥ Normal Links
¥ Active Links
¥ Visited Links
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n Use Defaults: Click this button to use the default preference 
settings. 

n Revert:You can go back to the preference settings that were in 
place before you opened the Preferences dialog box.

n Clear: Clears text entry Þelds.

n Apply: Applies changes and keeps the dialog box open.

n Cancel: Cancels any changes youÕve made to the preferences 
settings.

HTML Sets output defaults, including the following:
¥ Default Þle extension used for 

Web pages (.htm or .html)
¥ Proprietary line separators for 

Mac, Unix, or Windows/DOS.
¥ Return key mapping (<P> or 

<BR>). For more information 
about this feature, see ÒCreating 
paragraphs and line breaksÓ on 
page 3-11.

¥ Software, author, and date 
information in Þle header (META 
tags).

¥ Server Image Map Format

Source View Sets color for different types of  HTML syntax (as 
seen in the Source Editor), including the 
following:

¥ Font
¥ Font size
¥ Plain text
¥ HTML tags
¥ HTML source code comments
¥ Form attributes
¥ Form values

Preference tab Description of preference options
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Setting Web page defaults

If you want to customize the display of your Web page, Visual Page allows 
you to change speciÞc features.

To change the page defaults for a Web page:

1 Choose Properties, then Page from the Edit menu, or click the 
Page Properties button in the toolbar. 

The Page Properties dialog box appears:

2 Use the attributes in the Page Properties dialog box to set the 
documentÕs attributes. These attributes are described in the table 
below.

3 Click OK when youÕve Þnished setting the desired options.

Property type Description

Page Title The title of  the document. This is NOT the same 
as the documentÕs Þlename Ñ it is used for 
reference purposes only. ItÕs displayed in a 
browser applicationÕs title bar.
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The following buttons appear on the Page Properties dialog box:

OK: Click this button to apply changes and close this dialog box.

Cancel: Click this button to cancel any changes youÕve made to the 
properties settings.

Apply: Click this button to apply the changes and keep the dialog 
box open.

Background image Sets the background image for your Web 
page. For more information on this feature, 
see ÒCreating tiled backgroundsÓ on page 5-9

Background color Sets the background color of  the page.

Normal text color The color of  the document's text.

Normal links color The colors used for hypertext links. For more 
info, see ÒSetting the color for normal linksÓ on 
page 4-4.

Active links color The color used for links as they are active. For 
more information, see ÒSetting the color for 
active linksÓ on page 4-6.

Visited links color The color used for links that, when viewed in a 
browser, have been visited by a user. For more 
information, see ÒSetting the color for visited 
linksÓ on page 4-6.

Base URL Sets the Base URL for your document. The 
Base URL is the directory location upon which all 
the links in a Web page are based. For more 
information, see ÒCalculating Þle transmission 
timesÓ on page 8-25.

Base target The base target for all the links in the Web page. 
This lets you specify whether links open 
documents in a new window, the same window, a 
new frame, or the same frame. For 
information on setting the base target for a 
frame, see ÒSetting the frame targetÓ on page 6-
11. 

Property type Description
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Note: If you applied changes with the Apply button, Cancel does not undo 
those changes.

Starting a Web page
The Þrst step in using Visual Page is creating Web pages. There are several 
ways that you can start a Web page: 

n From scratch

n From an existing Web page in your computer or from the World 
Wide Web

n From a template

You can create individual pages, and include them into a project once they 
are done, or create a new page from within a project.

Note: Like most other types of media, Web pages are copyrighted material. 
Exercise caution when downloading other peopleÕs Web pages, especially 
if you plan to use all or part of what you download on your Web page. 
Generally speaking, unless you see an explicit statement on the Web site 
that the siteÕs contents are entirely of the Web authorÕs own creation, and 
are to be used freely and without charge, assume that the siteÕs contents 
are not for indiscriminate use.

Starting a Web page from scratch

Starting a Web page from scratch is the best approach if you want to create 
a completely original Web page. For example, if you have a client that 
wants to implement a completely new Web site design, this is a good place 
to start.

When creating a new page, be sure to decide if you want your page to be 
frame-based or not. Adding frames into a Web page at a later time involves 
extensive coding in HTML Ñ enough so that you should plan this in 
advance and select the correct command when beginning the page.
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To start a Web page from scratch:

n Select New from the File menu. If you plan for your Web page to 
include frames, select New Frame Set instead. 

A new, untitled Web page opens.

Now that youÕve got your Web page started, you can add text, insert 
graphics, tables, and advanced features Ñ such as plug-ins, Java applets, 
JavaScript code, or forms. If you want to preview your document, or view 
its HTML source code, be sure to see the sections covering preview and 
source code modes later in this chapter.

After youÕve entered the content into your Web page, remember to save it. 
If you want, you can also print the Web page. Information on saving and 
printing your Web page is explained later in this chapter.

Starting a Web page from an existing page

You can use Visual Page to create a new page from an existing one. This is 
a good approach if you need to create several pages that are similar in 
appearance, as you wonÕt need to reenter the elements of your Web page 
every time. There are two ways to create a Web page from an existing one: 
starting from a Web page already stored on your computerÕs hard drive, or 
by using a Web page from off of the Web. 

To start a Web page based on a local one:

1 Open the desired Þle in Visual Page. If your Þle is part of a project, 
open the project Þrst. See ÒOpening projectsÓ on page 2-6 for more 
information.

2 Save the Þle under a new name by selecting Save As from the File 
menu. 

3 Modify the Þle as desired. Make sure to save your changes.

If you open a Web page that contains tags that arenÕt supported by Visual 
Page, the opening and closing tags are indicated by opening and closing 
tag icons. To modify these tags, either double-click on them, or open the 
Þle in the Source Editor. For details on using the Source Editor, see 
ÒViewing the HTML codeÓ on page 2-17.

Now that youÕve got your Web page started, you can add, edit or delete 
text, graphics and other elements. See the appropriate chapters for 
information on how to do so. If you want to preview your document, or 
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view its HTML source code, be sure to see the sections covering preview 
and source code modes later in this chapter.

After youÕve entered the content into your Web page, remember to save it 
under a new name. If you want, you can also print the Web page. 
Information on saving and printing your Web page is explained later in this 
chapter.

If you have the URL for a Web page, you can download it from within 
Visual Page, then modify it to create a new page. 

To download an existing Web page:

1 From the File menu, select Download Remote File.

2 Enter the URL for the Þle.

3 Click OK. A Save As dialog box appears. 

4 Navigate to the folder that you want to save the Þle to and enter 
the new Þlename (if you wish to change it from the existing 
Þlename).

5 Click Save. The Þle you selected downloads, and displays.

Now that youÕve downloaded your Web page, you can add, edit or delete 
text, graphics and other elements. See the appropriate chapters for 
information on how to do so. If you want to preview your document, or 
view its HTML source code, be sure to see the sections covering preview 
and source code modes later in this chapter.

After youÕve entered the content into your Web page, remember to save it. 
If you want, you can also print the Web page. Information on saving and 
printing your Web page is explained later in this chapter.

Starting a Web page from a template

Visual Page includes several ready-made templates that can be used as the 
basis for Web pages. When you create a page based on one of these 
templates, all of the text formatting, graphics, and other elements within 
the template page are included in your new page. This can save you a 
great deal of design time over creating a page from scratch. It also gives 
you a good foundation for creating your Web site.
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To start a Web page from a template:

1 From the File menu, select Open. 

Select the Þle ÒVisual Page.htmlÓ in the Templates subdirectory in the 
Visual Page directory.

2 Click Open. 

The Visual Page DesignerÕs Toolkit displays. 

3 If Visual Page isnÕt in preview mode, change to this mode by 
clicking on the Preview Page toolbar button.

4 Click the Templates button in the Web page. The templates page 
displays.

5 Make sure that youÕre in Preview mode by clicking on the Preview 
Page toolbar button.

6 Read the description of the Visual Page templates, then choose a 
template from the Web page icons.

7 From the File menu, choose Save As. 

The Save As dialog box appears.

8 Enter the Þlename for your Web page, and click OK. 

You now have your own Web page, based on one of the template 
pages.

Now that youÕve got your Web page started, you can add, edit or delete 
text, graphics and other elements. See the appropriate chapters for 
information on how to do so. If you want to preview your document, or 
view its HTML source code, be sure to see the sections covering preview 
and source code modes later in this chapter.

Previewing your work
Visual Page provides two modes for working with Web pages. The Edit 
mode is used to create and modify Web-based content. The Preview 
mode is a way to view documents as they appear in a userÕs browser.

To switch to the edit mode, click the Edit toolbar button. Likewise, to 
switch to the preview mode, click the Preview toolbar button.

You can also view your work in multiple browsers that are conÞgured in 
Visual Page preferences. To conÞgure which browsers you want to work 
with see ÒSetting global preferencesÓ on page 2-7.
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Viewing the HTML code
In addition to modifying Web content in the edit window, you can edit the 
HTML code for your Web pages in the Source Editor. The Source Editor 
allows you full control over the code that makes up your Web page. It is 
similar to using a text editor to create HTML code, but includes additional 
features, such as automatic coloring of HTML tags and changing font sizes.

Changes that are made in the Source Editor are automatically reßected in 
the edit area of the main editing window, once the main editing window is 
made active. For example, if you enter the source code for a Heading 1 tag 
(<H1> and </H1>) in the Source Editor, then select the main edit window, 
the area you put the tags around appears in Heading 1 format.

To switch to the Source Editor:

1 Select the Edit Source button from the toolbar, or select Edit 
Source from the View menu.

The Source Editor opens:
2-17



Chapter 2: Creating Web pages
Saving a Web page
As you are creating your Web pages, it is a good idea to save your work 
periodically.

To save a Web page:

1 From the File menu, select Save. If you want to save a previously-
saved Þle under a different name, select Save As. 

The Save (or Save As) dialog box opens:

2 Navigate to the folder to which you want to save the Þle. 

3 If this is the Þrst time youÕre saving this Þle, enter a name for the 
Þle. The Þle extension will automatically be added, according to 
the Þle extension preference setting. For more information, see 
ÒSetting site optionsÓ on page 8-12.

4 Click OK.

Note: When you use the Revert feature in Visual Page, you revert to the 
last saved copy of your Web page or project.

Printing a Web page
Visual Page supports WYSIWYG printing of Web pages. The default print 
setting is to print one copy of the entire document.
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To print a Web page:

1 (optional) From the File menu, select Print Setup and select the 
page size, orientation, and printer effects you want. Visual Page 
remembers the settings once you click OK.

2 Enter the printing-speciÞc information for your print job.

3 Click OK to save your settings and print the Þle.

What’s next
In the next chapter, we cover Visual PageÕs extensive features for creating 
and formatting HTML-based text, including text alignment, paragraph and 
character formatting, and manual insertion of HTML tags, and working with 
style sheets.
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Working with text

Visual Page offers a full range of Web-based authoring and design tools. 
Working with text in Web pages using Visual Page is very similar to 
inserting and formatting text using any standard word-processing 
application. For example, you can add structure and style to your text by 
applying formatting and styling options, such as bold and italic text, or 
assigning a cascading style sheet.

This chapter covers the range of text insertion and manipulation tools 
within Visual Page, including formatting of paragraphs, characters, tags, 
and pages; text alignment and coloring; inserting HTML tags; Þnding and 
replacing; and checking your spelling. 

Inserting text into a Web page
You enter text by typing in the main edit window. Any text you enter 
appears at the insertion point, which is indicated by the text cursor. The 
text cursor appears as blinking vertical line.

The main ways of inserting text in Visual Page are typing, dragging and 
dropping, and copying and pasting.

After you Þnish inserting your text, donÕt forget to preview your Web page. 
For instructions on using the Preview mode, see ÒPreviewing your workÓ 
on page 2-16.
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Typing text into a Web page

By default, Visual PageÕs operating mode is Edit mode. You can enter text 
into any open Web page as long as you are in Edit mode.

To insert text into a Web page by typing:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Position the insertion point by placing the cursor over the desired 
insertion point and single-clicking.

3 Enter your text.

Dragging and dropping text into a Web page

When you drag and drop text in Visual Page, a copy of the source text is 
made. 

To insert text into a Web page by dragging and dropping from another 
Web page:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Open the Web page from which you want to drag the text. This is 
the source page.

3 Open the Web page into which you want to drag the text. This is 
the destination page.

4 Arrange the two Web page windows so that you can see both on 
your computer screen.

5 Within the main edit window of the Web page that contains the 
source text, select the text you want to insert into the other Web 
page.

6 Place the mouse pointer on the selected text and drag the text to 
the location in the destination Web page. 

7 Release the mouse button. 

Your text is copied from the source Web page to the destination 
page.
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Copying and pasting text into a Web page

You can copy text into Visual Page by using standard Windows operations, 
even from another application.

To insert text into a Web page by copying and pasting:

1 If the Web page that you want to copy the text from isnÕt open, 
open it now. This is the source page.

2 If the Web page that you want to paste to isnÕt open, open it now. 
This is the destination page. Make sure that this page is open in 
Edit mode by clicking the Edit Page toolbar button.

3 Within the main edit window of the source page, select the text 
you want to insert into the destination page.

4 From the Edit menu, select Copy.

5 Move the text cursor to the place in the main edit window where 
you want the insertion point placed, and single-click.

6 From the Edit menu, select Paste. 

The text is copied to the new location.

TIP: If you are in Preview mode, you can automatically switch to Edit 
mode by typing in text. Visual Page places the text at the last cursor 
position in the active Web page.

Formatting text
Visual Page supports three types of text formatting: paragraph formatting, 
character formatting, and formatting tags and pages using cascading style 
sheets. 

Paragraph formatting is used to apply a group of predeÞned styles and text 
alignment attributes to a paragraph. For example, if you want a piece of 
text to look like a heading, you apply the Heading 1 format to that text. 
The text is then displayed with the style and text alignment attributes 
deÞned for that format. 

Character formats are used to make individual characters or groups of 
selected characters stand out in your text. For example, applying bold or 
italic to a section of text increases the visibility of a word within a text 
block.
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You can also format paragraph and character styles by using cascading 
style sheets. You can use the many style sheet features in Visual Page, or 
apply them from the main toolbar. For more information on using style 
sheets, see ÒFormatting tags and pages with style sheetsÓ on page 3-12.

Formatting paragraphs

Use paragraphs formats to organize the look and structure of information 
in your Web page. 

Applying paragraph styles

Paragraph styles are intended to be applied according to the type of 
information contained within their target paragraph; for example, you 
would apply the Heading 1 format to the topmost headers in your Web 
page. When you start typing in Visual Page, the default paragraph style is 
set to Normal.

Paragraph styles are ultimately determined by Web browser settings rather 
than the formats you apply. For example, a bullet list may look different in 
various browsers, depending on the settings each uses. The actual font and 
font size your paragraph displays is set in the Web browser by the person 
viewing your Web page. 

Note that the use of style sheets can also be used to make the look of 
pages and tags standard. However, the look can vary widely depending on 
the browser. 

To apply a paragraph style:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the paragraph you want to format by clicking anywhere 
within it.

3 Click the arrow in the style box on the toolbar. 

A drop-down list of paragraph styles appears.

4 Choose the paragraph style you want to apply.

Visual Page supports the following paragraph styles:
3-4



Formatting text
Paragraph style Description

Normal The Normal style is the default format when you 
create a new paragraph. The text appears ßush left 
in the page window and is displayed in the Visual 
Page default font. This style is also selectable from 
the style drop-down menu. Most of  the text in 
your Web pages should be formatted with this 
style.

Headers Header styles are used to make headlines or titles 
distinct from the rest of  the text in a page. In 
general, headers are larger than the Normal 
format, and are in a bold type face. Visual Page 
supports the heading styles Heading 1 through 
Heading 6.

An alternative to using a header format is to 
manually specify the font size of  a text 
block, using the Increase Font Size button. 
Creating headers in this way allows you 
greater control over the relative size of  your 
headers.

Preformated The Preformatted paragraph style is used as a way 
to maintain text formatting that uses multiple 
spaces and tabs, such as the formatting found in 
code segments. 

Preformatted paragraphs are displayed in 
mono-spaced fonts, such as Courier. 
Monospaced fonts use equal spacing for all 
characters, regardless of  the individual 
characterÕs size: for example, the letter ÒlÓ 
takes up the same amount of  space as the 
letter ÒWÓ. This allows for easy formatting of  
large blocks of  difÞcult to read text, such as 
is found in computer code.
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Applying paragraph alignment attributes

Paragraph alignment attributes are used to organize and set off 
information. Examples of paragraph alignment attributes are justiÞcation 

Address format Web site authors typically apply the Address style 
to the paragraph that contains a contact address 
for the creator of  the Web site. As is the case with 
all the paragraph formats, the Þnal appearance is 
dependent on the browser which displays it. Most 
Web browsers use an italic format in the Address 
style, which is the convention Visual Page uses as 
well. 

Choosing to include an address is a matter of  
style. When you include an address, make sure to 
link it so that the browser jumps to email when 
the link is clicked. 

Note: The Address style does NOT create a 
link to an email address! To create an email 
link, see ÒCreating email address linksÓ on page 4-
7.

List formats When you apply the Bullet style to a paragraph, 
Visual Page indents the text and places a bullet 
character to the left of  the text in the paragraph. 
You use this style to create bullet lists ÑÊan 
unordered list of  items or topics. This is useful if, 
for example, you want to create an online 
presentation highlighting several main topics.

The term and description styles are designed to be 
used together in lists of  deÞnitions. The format is 
similar to what you would Þnd in a Glossary: the 
Term style is used to format the glossary word, 
and the DeÞnition style is used to format the 
deÞnition of  the word.

Applying the Term format to a paragraph places 
the paragraph text ßush left at the left margin. 
When you press the return key after applying a 
Term format to a paragraph, Visual Page 
automatically applies the Description format, then 
indents the text of  the paragraph.

Paragraph style Description
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and indents. Indents guide the readerÕs eye through the contents of the 
Web page. Breaks that are properly placed throughout text allow the 
reader to pause, much like a break in between thoughts, and continue 
reading when ready. 

JustiÞcation adds consistency to the visual spacing and layout of objects 
and text. It can be used to align text without the use of frames or tables. 
Usually, left-justiÞed text is used for long blocks of text, making your 
document easier to read. Right-justiÞed text is often used for short and 
small blocks of text, such as brief quotations.

To index a block of text:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button.

2 Select the paragraph you want to format by clicking anywhere 
within it.

3 Decrease or increase the paragraphÕs indenting, by clicking the 
appropriate indentation button.

To justify a block of text:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button.

2 Select the paragraph you want to format by clicking anywhere 
within it.

3 Click the Align Left, Align Center, or Align Right alignment button.

Formatting characters

Use character styles to make individual characters or groups of selected 
characters stand out in your text. 

Applying character styles

You apply character styles by selecting text, then choosing a style from the 
main toolbar. These character styles include applying fonts and font sizes, 
color, as well as other standard character styles. 

When you start typing in Visual Page, the default charcter style is 12-point 
Times New Roman.
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To apply a character style:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the character(s) you want to format by clicking at the 
insertion point, then dragging to the end of the selection.

3 Choose a character style from the Text menu.

The character styles supported by Visual Page are described in the table 
below.

Character style Description

Plain Unformatted text.(default)

Bold Bold text; for example, bold.

Italic Italicized text; for example, italic.

Superscript Superscripted text; for example, 1.

Subscript Subscripted text; for example, 1.

Strike Thru Strike-through text; for example, delete this 
phrase.

Fixed Width A non-proportional font (similar to the 
Preformatted paragraph style); for example, 
fixed width.

Underline Underlines text, for example, underline

Emphasis Italicized text; for example, italic.

Strong Emphasis Bold text; for example, bold.

Citation Italicized text; for example, italic.

Code A non-proportional font (similar to the 
Preformatted paragraph style); for example, 
code.

Variable Italicized text; for example, italic.

Keyboard A non-proportional font (similar to the 
Preformatted paragraph style); for example, 
keyboard.
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Note: Though some of these character styles are similar, how they display 
depends on each browserÕs settings. 

Changing font sizes

Visual Page allows you to set the relative font size of a block of text. For 
example, if you want to create a drop cap (a type of formatting where the 
Þrst character of a paragraph is larger than the rest of the paragraph), 
Visual PageÕs formatting tools let you do this.

Visual Page uses Medium as the ÒnormalÓ font size. This size is equivalent 
to the size of the display font, as set in the Web browser. The other names 
signify either a smaller or larger font than the one set as normal in the 
browser, with XX-Small being the smallest font size and XX-large the 
largest font size. 

To change font sizes:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the text you want to resize by clicking at the insertion point, 
then dragging to the end of the selection.

3 Click the Decrease or Increase button in the toolbar.

4 (optional) Check the size of the font by choosing Size from the 
Text menu. The size is indicated by a checkmark.

If you want to change the font size of a line of text, you can use a header 
style. For more information, see ÒFormatting paragraphsÓ on page 3-4.

If you are creating style sheets, you can use absolute font sizes. Absolute 
font sizes use numbered point sizes.

Applying fonts

Visual Page can use the fonts that are installed into your operating system. 
This feature is advantageous if you are creating Web pages that will be 

Sample A non-proportional font (similar to the 
Preformatted paragraph style); for example, 
sample.

Character style Description
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viewed by users who have the same operating system and the same or 
similar fonts, for example, on an Intranet.

To apply fonts in selected text:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the text you want to modify by clicking at the insertion 
point, then dragging to the end of the selection.

3 Click the Font pull-down menu and select the font you want to 
apply.

The new font is applied.

Working with font groups

Font groups are groups of fonts that usually have some common 
characteristic to preserve the original design of the Web page. Font groups 
allow the Web browser to substitute fonts from a group of assigned fonts 
when one or more fonts are not available on the client machine. When no 
font in a group is available on the client machine, the Web browser uses 
default fonts available on the client machine.

With Visual Page you can create and assign font groups that make your 
pages look their best across different platforms and browsers.

To create a font group:

1 From the Font pull-down menu, select Font Groups.

The Font Groups window opens with the names of default font 
groups:
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2 Click a blank cell in the Group Name column and enter a name for 
the new font group.

3 Click the Font Names cell and enter font names separated by a 
comma.

4 Click OK when you are Þnished entering font names.

The font group is added to the Font pull-down menu.

Note: The order of the fonts speciÞed under Font Names is important 
because if the Þrst group is not found on the client machine, then the 
second font in the group is used.

To select a font group:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the text you want to modify by clicking at the insertion 
point, then dragging to the end of the selection.

3 Click the Font pull-down menu and select the font group you want 
to apply.

The font group is applied.

Coloring text

Visual Page allows coloring of text, based on the standard Windows color 
palettes. 

To color a block of text:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select a block of text to color by clicking at the insertion point, 
then dragging to the end of the selection.

3 Click the Text Color button in the toolbar. A color palette menu 
appears.

4 Select the color you want from the color palette. 

If you want a custom color, click Custom and create your color by 
clicking in the color box or by setting the Hue, Saturation, 
Lumination, and Red, Green, Blue amounts. Once youÕve created the 
desired color, click the Add to Custom Colors button, and your 
custom color is added to the Custom colors palette area.
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5 When youÕve chosen the color you want, click OK.

Formatting tags and pages with style sheets

Visual Page supports the creation and use of cascading style sheets, often 
referred to as CSS, or even style sheets. With style sheets, you can 
standardize your Web site without having to write the HTML or style sheet 
source yourself as well as add styles that are not possible with existing 
HTML-local styles. 

Style sheets are a powerful feature for standardizing your Web site. For 
example, you can import an existing site, create a style sheet with new text 
and paragraph styles, then apply the style sheet to the whole site using it 
as the default style sheet. Instantly, your site contains a new and consistent 
look. You won't need to apply the style sheet to every page individually; it 
is done for you automatically by Visual Page. 

ÒCascadingÓ means that any number of style sheets can be applied to a 
Web page or sets of Web pages, and that the Web browser will interpret 
and display them within a Þxed order of priority: inline, local, and external.

SpeciÞcally, cascading style sheets allow you to control the format of HTML 
tags globally (some or all of the Web pages in your site) or locally, i.e. only 
speciÞc tags at speciÞc points within a single Web page. Also, you can 
eliminate repetitive code in your document, such as applications of fonts 
and colors. Make sure your browser is able to interpret cascading style 
sheets, since styles will not display in older browsers or text-only browsers 
such as Lynx.

Understanding style sheets

There are three basic ways you can work with cascading style sheets: 
linked, local, and inline. Each has their advantages. Inline styles are used to 
apply styles to speciÞc tags at speciÞc points in your Web page. A local 
style sheet is where the style deÞnitions are placed directly in the Web 
page. A linked style sheet is a CSS document that acts as a master style 
sheet.

The power of style sheets allows you to redeÞne HTML tags that were 
previously Þxed or limited in their attributes. The following list is not 
exhaustive on what style deÞnitions you can redeÞne. You can refer to any 
of the Þne books on HTML and style sheets for more information, or go to 
www.w3.org.
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With the Page Style Sheets Editor, you create style sheets from scratch, 
from an existing style sheet, or from a template. When you create a style, 
you create a paragraph style or text style. A paragraph style is a style based 
on existing paragraph tag deÞnitions. For example, you can change the 
color and size of the <H1> tag to be almost any color, size, and font. All 
<H1> tags will have this new style, depending on which kind of style sheet 
you apply. ModiÞed paragraph styles have a + (plus sign) after the style 
name in the Paragraph Style drop-down box.

You can also create a new style that is based on existing HTML tags. When 
you select the Based On property, and give this new style a name, you can 
apply it throughout the Web page, or even Web site.

With Visual PageÕs Style Sheet Editor, you can also change the look of the 
traditional hyperlink, such as removing the underline or changing the 
color.

TIP: if you are new to style sheets, you can open the Source Editor and 
watch Visual Page create the style sheet source for your Web pages as you 
work in the Style Sheet Editor.

Creating linked style sheets

A linked (also called external) style sheet is a CSS document that acts as a 
master style sheet, and has the extension .css. A Web page utilizes that 
master style sheet by linking to it. You can apply a linked style sheet to any 
number of Web pages in your site, or standardize your entire Web site with 
only one document. 

Visual Page simpliÞes the creation of linked style sheets. One advantage of 
using a linked style sheet is that you can easily apply it to all Web pages in 
your site with the Project Manager. To change the styles in a linked style 
sheet, you modify the .css Þle.

You also create linked style sheets without having any open Web 
documents. The style sheet editor previews most style deÞnitions, but to 
view the application of a style sheet, you must open or create a Web 
document that uses the style sheet.

Note that you must correctly link and upload the linked style sheet because 
some Web servers canÕt send your pages (or entire site!) to the client 
requesting them. Visual PageÕs Project Manager simpliÞes this task. For 
more information, see ÒMaintaining your Web siteÓ on page 8-19
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To create a new linked sheet:

1 Select New Style Sheet File from the File menu.

The Style Sheet editor opens:

2 Click the Create New Style icon. The Style Attributes dialog box 
opens:

3 Create a new style by doing one of the following:
n If you want to redeÞne a base style, donÕt type anything in the 

Name text box.

Click the New 
Style icon to 
open the Style 
Attributes 
dialog box
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n Select a base style from the Base Style combo box.
n If you want to create a new style based on an existing base 

style, select the base style and type in a name for your new 
style.

n If you want to create a style that is not based on any existing 
styles, type in a name for the new style and leave the Base Style 
combo box set at Default Character Style. You can also change 
style attributes in the same dialog.

4 Click OK to create the new style.

Note: Items marked with an asterisk indicate that the property does not 
appear in the Visual Editor, but will appear in a CSS-compatible browser.

DonÕt forget to save your work!

To open an existing linked style sheet:

1 Select Open from the File menu.

The Open File dialog box appears.

2 From the Files of type pull down box, select Style Sheet Files 
(*.css).

3 Navigate to the appropriate directory that contains the style sheet 
you want to open and double-click on it.

The style sheet opens in the Style Sheet editor.

or

If you have added linked style sheets to the Page Style Sheets 
window, you can select it from there. To add style sheets to the Page 
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Style Sheets window, see ÒModifying, adding, and removing linked 
style sheetsÓ on page 3-16 for more information.

1 Right-click anywhere in an open Web page.

2 Select Page Style Sheets from the popup menu.

3 The Page Style Sheets editor opens.

4 Double click on a linked style sheet listed in the window.

5 The Style Sheet editor opens.

To create a style sheet based on an existing style sheet

1 Select Open from the File menu.

The Open File dialog box appears.

2 From the Files of type pull down box, select Style Sheet Files 
(*.css).

3 Navigate to the appropriate directory that contains the style sheet 
template you want to open and double-click on it.

The style sheet template opens in the Style Sheet editor.

4 Save your template with a new name using the Save As feature 
under the File menu before you begin working on it.

Modifying, adding, and removing linked style sheets

When you modify a linked style sheet from an open Web page, you open 
the Page Style Sheet window and select the style sheet you want to modify. 
If you have a linked style sheet on your computer, you must add it to the 
Page Styles Sheet window.

Double-click 
the name of 
the CSS file 
to open it.
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To modify a linked style sheet:

1 Open a linked style sheet by clicking the Open icon on the main 
toolbar.

2 Select .css in the Files of Type pull-down menu.

3 Navigate to and double-click the linked style sheet you want to 
open.

The Style Sheet editor opens.

4 Use the toolbar on the Style Sheet editor to access the Style 
Attributes dialog box.

Note: The Style Attributes dialog box can also be accessed by double-
clicking an existing style for modiÞcation.

or:

1 Right-click on an open Web page.

2 Select Page Style Sheets from the pop-up menu.

3 Double-click on the linked style sheet you want to open. To add 
style sheets to the Page Style Sheets window, see ÒModifying, 
adding, and removing linked style sheetsÓ on page 3-16 for more 
information.

The linked style sheet opens in the Style Sheet editor.

4 Use the toolbar on the Style Sheet editor to access the Style 
Attributes dialog box:

Create 
New 
Style

Edit Style 
Attributes
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To add an linked style sheet to an HTML page:

1 Right-click anywhere in an open Web page.

2 Select Page Style Sheets from the popup menu.

3 Click the Add button to navigate to the CSS Þle on your computer 
or network.

4 Double-click on the CSS Þle you want to add.

The CSS Þle is added to the CSS list in the Page Style Sheet editor.

Note: To add a global style sheet to your project, see ÒLinking and 
unlinking an external default style sheet to your Web siteÓ on page 8-12.

Removing a linked style sheet:

1 Right-click in an open Web page.

2 Select Page Style Sheets from the popup menu.

The Page Styles Editor opens.

3 Select the CSS file you want to remove.

4 Click remove.

The Þle is removed from the Page Style Sheets Editor.

Note: To delete the Þle from your computer, use the Project window. For 
more information, see ÒRemoving Þles and folders from a projectÓ on page 
8-8.

Using local style sheets

A local style sheet is where the style deÞnitions are placed directly in the 
Web page. Style deÞnitions are placed between <STYLE> tags, and the 
<STYLE> tags are placed between the <HEAD> tags of the Web page. Local 
style sheets are applied only to the Web page in which they reside. The 

Toolbar icon Function

Create New Style Opens the Style Attributes dialog box.

Edit Selected Style Attributes Opens the Style Attributes dialog box with the 
attributes of  the selected style.
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advantage of using local style sheets is that you can control the look and 
feel of a particular page without affecting the rest of your Web site.

Style deÞnitions contained in a local style sheet override style deÞnitions 
contained in an linked style sheet when there is a conßict. You must have 
an open Web document in the Visual Page editor and be in Edit mode to 
work with local style sheets.

To create a local style sheet:

1 Open a Web document in the Visual Page editor.

2 Right-click anywhere in the Web document and select Page Style 
Sheet.

The Page Style Sheets window opens.

3 Click the Local Styles button.

The Local Styles Editor opens:

4 Click the Create a New Style icon. 

The Style Attributes dialog box appears.

5 Set attributes to your new style and click OK to apply your 
changes and close the Style Attributes dialog box.

The new style is placed in the Styles window.

TIP: You can edit a local style sheet in the Attributes window if you have 
checked this property in the Preferences dialog.
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To edit a local style:

1 In the Local Styles Editor, select the local style in the Styles 
window.

2 Click the Style Attributes icon or double-click the style.

The Style Attributes dialog box appears.

3 Set attributes of the style and click OK to apply your changes.

The changes are applied to the page.

To remove a local style:

1 In the Local Styles Editor, select the local style in the Styles 
window.

2 Click the Delete icon or press the Delete key.

The selected style is removed from the Local Styles Editor.

Creating inline styles

Inline styles are style deÞnitions that apply only to the immediate tag and 
all local deÞnitions are placed between opening and closing <SPAN> tags. 
They do not override the standard HTML tags in the rest of the Web page, 
but they override any style deÞnitions from an external or local style sheet 
at that particular instance in your Web page. For example, inline styles can 
be used to control the indentation or spacing of a single paragraph only. 
The advantage to using inline style deÞnitions is that you can Þne-tune 
your Web page at speciÞc points, such as empathizing important 
information.

You deÞne inline styles with the Inline Style Attributes dialog box. When 
you are creating a character inline style, there are six tabs similar to the 
Style Attributes dialog box. For descriptions of these tabs, see ÒUsing the 
Style Attributes dialog boxÓ on page 3-23.
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When you are creating an inline style for paragraphs, the Paragraph tab 
appears in the Inline Style Attributes dialog box:

Note: items marked with a Ô*Õ indicate that they are not visible in the Visual 
Editor, but display in a CSS-enabled Web browser.

To create an inline style: 

1 With a Web page open in Visual Page, select the text or objects 
you want to modify.

2 You can apply inline styles by using the toolbar icons, such as 
color, fonts, font sizes, etc. However if you are creating an inline 
style within an external style sheet, these toolbar items are not 
available.

Paragraph tab Description

Alignment Left, right, or center justiÞcation

Indent Increase or decrease indent

Line height Spacing between lines

Whitespace Spacing around selected paragraph

The Paragraph 
tab appears 
when you apply 
an inline style 
as a paragraph 
istyle.
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or

1 Press F10 to create an inline character style, or Shift + F10 to create 
a paragraph inline style.

The Inline Styles window opens.

2 Create the inline style by using any combination of the styles in 
the Inline Styles window.

3 Click Apply to see your changes take effect in the Editor if they are 
supported in the Visual Editor.

4 Click OK to apply all changes and close the Inline Style window.

Applying styles from other style sheets

You can apply styles from other style sheets. If youÕve created other 
external or local sheets and added them to the Page Style Sheets window, 
you can apply them at the paragraph style level or at the text style level 
from the main toolbar. You can also apply them with the Show Styles 
window.

To open the Show Styles window:

n From the View menu, select Show Styles.

The Show Styles window appears:

Feature Description

Styles window Lists all available styles to apply
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To apply a style based on another style:

1 Highlight the text to which you want to apply a style.

2 If you are applying a paragraph style, select the style from the 
Style pull-down box. If you are applying a text style, select it from 
the Styles pull-down box. Available style sheets are at the bottom 
of the menu.

or

1 Highlight the text to which you want to apply a style.

2 Click on the style from the Show Styles window.

3 Apply the style from the Apply On combo box.

Note: the styles available in the Show Styles window depend on what you 
select. For example, paragraph styles are not available when you select a 
portion of a paragraph.

Using the Style Attributes dialog box

The Style Attributes dialog box is where you set attributes for style sheets. 
The Style name shows the name of the style you are editing. Based On 
drop-down box lets you deÞne a new style for a standard HTML tag.

Note: Styles marked with a Ô*Õ are not visible in the Visual Editor, but can 
be viewed in a CSS-enabled browser.

To acces the Style Attributes dialog box:

1 Right-click anywhere in an open Web page.

2 Select Page Style Sheets.

The Page Style Sheets editor appears.

3 Click the Local Styles button.

The Local Styles Editor opens.

Apply on Selection: applies style to the selected area within 
a paragraph

Paragraph: applies style to a paragraph

Feature Description
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4 Click the Create New Styles icon to open the Style Attributes dialog 
box:

 

Font tab Description

Font Applies font or font groups.

Size Applies font size
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5 When you have Þnished selecting attributes, click OK to apply the 
changes and close the Inline Style Attributes dialog box. You click 
Apply to apply your changes without closing the editor. If you 
want to cancel your changes altogether, click close.

Note: Close does not undo previous changes that were applied.

Text decorations Text color: selects text color based on Windows 
palette.

Default: uses default character style

None: uses no text decoration

Blink: sets text to ÒblinkÓ

Underline: applies underline text decoration

Overline: applies overline text decoration

Line through: applies line through text decoration

Style: applies default, italic, normal, or oblique 
text styles

Weight: applies various degrees of  bold-face text 
styles

Transform: applies default, none, capitalization, 
upper- and lower case text styles

Variant: applies default, normal, or small caps text 
styles

Font tab Description
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Background attributes tab

You control the background color and image display in the Background 
tab of the Style Attributes dialog box.

Background tab Description

Images Default: uses Visual Page defaults

No image: uses no image

Image Þle: selects image Þle to be used as a 
background

Background Color Sets background color from CSS RGB palette

Position Applies horizontal, veritcal, repeated, and 
attachment properties.
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Borders/Margins tab

You create custom borders and margins with the Borders/Margins tab.

Borders/Margin tab Description

Apply to Applies the Borders, Margin, and Padding 
properties to the four sides around an object:

¥Left

¥Top

¥Right

¥Bottom

Borders Creates a border around an object, with respect 
to:

¥Color

¥Style: select from default, dashed, 
dotted, double, groove, inset, 
none, outset, ridge, and solid.

¥Width: sets the width of  a border

Margin Creates an outer edge around an object.
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Bullets and numbering tab

You apply bullet and numbering styles through the Bullets tab.

Padding Creates space between the border and the text or 
object when viewed in the browser.

Borders/Margin tab Description
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Bullets and numbering tab Styles available

Type Creates a shape or text style to be used as a 
list marker

Default: disc is the default list marker

None: uses no marker in a list item.

Disc

Circle

Square

1, 2, 3...

i, ii, iii...

I, II, III...

a, b, c...

A, B, C,...

Image Permits the use of  an image as a list marker, 
such as a bullet.

¥Default

¥None

¥From File

Position Places the list marker inside or outside of  the 
list.

¥Default: outside is the default list 
marker position

¥Inside

¥Outside
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Advanced tab

The Advanced Tab is where you apply advanced style sheet features.

Advanced tab Properties

Clear Tells the Web browser not to place ßoating 
objects at speciÞed positions:

¥Default: this value is set to None.

¥None: this property is the same as 
not inserting the clear property 
in the source code.

¥Left

¥Right

¥Both

Display Default

None

Block

Inline

List-item
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All Styles tab

The All Styles tab display the current styles of selected text. You can edit 
this window directly and add or subtract features of the other tabs.

Float Allows an image to ßow left or right of  text:

¥Default

¥None makes the image display 
where it appears in the text.

¥Left

¥Right

Spacing Changes the default value of  letter or word 
spacing. You can set values to negative 
numbers as well as positive numbers

¥Letter

¥Word

Vertical alignment Determines the vertical positioning of  an 
object. you can set values to negative or 
positive numbers.

Advanced tab Properties
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Creating paragraphs and line breaks
Visual Page supports two types of text line separators: paragraph markers 
and line breaks. A line break simply indicates the ending of a line, where a 
paragraph marker indicates the ending of a styleÕs formatting block. For 
example, if a block of text has the Heading 1 style applied to it, this 
formatting will end once a paragraph marker is encountered. 

The Return key is set to either insert a line break or a paragraph marker, 
depending on the settings in the Output section of the Preferences 
window. For information about the Preferences window, see ÒSetting 
preferencesÓ on page 2-7. 

The Shift-Return key combination always generates the opposite of what 
the return key setting is; for example, if the return key is set to insert a 
paragraph marker, Shift-Return inserts a line break. The default setting is 
for the Return key to generate a paragraph marker.

Adding additional HTML tags
In addition to the wide range of styles that Visual Page supports, Visual 
Page lets you insert any HTML tags as well, including browser-speciÞc 
tags. This feature expands your range of text formatting options as new 
HTML tags become available. 

When inserting an HTML tag, you can add it two ways: from the Insert 
menu, or by hand. If youÕre doing it by hand, include both the beginning 
and ending tags, when applicable. For example, the <BLINK> tag must 
have a corresponding </BLINK> tag, otherwise all of the text and graphics 
following <BLINK> will be formatted with the <BLINK> tag until the end of 
the Web page.

To insert an HTML tag with Visual Page:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place the insertion point where you want the tag.

3 Choose HTML Tag from the Insert menu.

4 Type in the desired HTML tag in the HTML tag Þeld, without 
opening and closing brackets (< and >). For example, to insert a 
<STYLE> tag, type STYLE.

5 Click OK.
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Visual Page inserts the tag and represents it with a tag marker.

After you Þnish entering your HTML tags, you can preview your Web page. 
For more information, see ÒPreviewing your workÓ on page 2-16.

Adding HTML tags to a source file

In addition to adding HTML tags via the HTML tag menu, you can add 
HTML tags directly into Visual PageÕs source window. 

Note: The steps below assume that you are familiar with entering HTML 
tags manually.

To add HTML tags through the Source Editor:

1 Open a Web page.

2 Go into the source editor by selecting the Edit source button from 
the toolbar, or by pressing Ctrl-Shift-E. 

3 In the main edit window, place the text cursor where you want to 
add the tag.

4 Enter the HTML tags. 

5 Switch to the visual editor. Your tags are reßected accordingly.

6 Save your work by choosing Save or Save As from the File menu.

Adding special symbols and characters
You can add special symbols and characters to your Web pages without 
needing to know the HTML code for them. Accented characters and 
symbols such as trademark, copyright, and others are available to you.

Normally, to insert special symbols and characters which donÕt appear on 
standard keyboards, you need to select Special Character from the Insert 
Menu. 

If you prefer to enter the symbol or character HTML codes yourself, you 
can do that the same way you enter HTML tags in the source editor. See 
ÒViewing the HTML codeÓ on page 2-17 for more information on editing 
the HTML source of a Web page.
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You can also add any character with keyboard combinations, such as 
pressing ALT and typing the ASCII value for the character. You can also 
copy and paste from the Windows Character Map.

To add special symbols or characters to a Web page:

1 Open or create a Web page. 

2 Make sure youÕre in Edit mode by clicking the Edit Page toolbar 
button.

3 Select Special Character from the Insert menu, and click on a 
character. 

The character is inserted into the Web page.

Using the Spell Checker
You can check the spelling in your page at any time by clicking the Spell 
Check icon or touching the F7 key. The Spell Check checks the spelling in 
the entire page. 

You can also make the Spell Checker ÒlearnÓ words by adding them to the 
Personal Dictionary. See ÒWorking with the Personal DictionaryÓ on page 
3-35 for more information.

After you are done checking the spelling of your page, save your page so 
that your corrections are also saved.

To start the Spell Checker:

n Click the Spell Checker icon on the toolbar.

The Spell Check dialog box opens.
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The functions available are: 

Ignore skips the current word and continues spell checking.

Ignore All skips all instances of this word.

Add places the current word into the dictionary.

Change replaces the current word with the word in the Change To 
Field, or to the word that is highlighted in the Suggestions window.

Change All replaces all instances of this word with the word in the 
Change To window or to the word that is highlighted in the 
Suggestions window. Note that the replacement of all instances of a 
word occurs except for words previously selected as Ignore.

Suggest automatically provides a list of alternatives to the current 
word.

Edit Dictionary opens the Personal Dictionary. In the personal 
dictionary, you can add, modify, or delete entries.

Cancel exits the Spelling Checker, but does not cancel any previous 
spelling changes made with the Spelling Checker.

Working with the Personal Dictionary

You can add, delete, or edit your own entries to the Personal Dictionary. 
These features are useful when you are writing text with highly specialized 
vocabulary, such as acronyms and technical terms. The Spell Checker uses 
its own dictionary as well as the Personal Dictionary when checking 
spelling.

To add entries to the Personal Dictionary:

1 Click the Spell Check icon to open the Spell Checker.

2 Click Edit Dictionary.

The Edit Dictionary window opens.

3 Click Add. 

The Insert text box opens.

4 Type the word you want to add to the dictionary.

5 Click OK to close the Insert text box.

The new word is added to your Personal Dictionary.
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To delete entries to the Personal Dictionary:

1 Click the Spell Check icon to open the Spell Checker.

2 Click Edit Dictionary.

The Edit Dictionary window opens.

3 Single click the word you want to delete.

4 Click Remove. 

The selected word is deleted from your Personal Dictionary.

To edit words in the Personal Dictionary:

1 Click the Spell Check icon to open the Spell Checker.

2 Click Edit Dictionary.

The Edit Dictionary window opens.

3 Single click on the word you want to edit.

4 Click Edit. 

The Change text box opens.

5 Make your correction to the word.

6 Click OK to close the Change text box.

The modiÞed word is added to your Personal Dictionary.

What’s next
In the next chapter, we explore creating, formatting, and testing hypertext-
based links and anchors in Visual Page.
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Adding links and anchors

Links and anchors allow you to create connections between Web pages. 
When a user clicks on a link in a browser application, the browser displays 
the Web page that the link or anchor points to. The link can be an object, 
text, an image, or a portion of a image. 

This chapter covers the processes of inserting and manipulating links and 
anchors within Visual Page by using a variety of tools, and the steps 
involved in testing your links and anchors. You can also use the Pr oject 
manager to work with links and anchors across an entire Web site.

Inserting links
Visual Page lets you insert links in a variety of ways, including dragging 
and dropping from the Project window onto a selection, entering an URL 
for a Þle or anchor in the Link To Þeld, dragging and dropping from the 
desktop onto a selection, and inserting a link with the Hyperlink toolbar 
button.

By default, the target display window for a link is the same window as the 
original Þle. This default can be changed in the Page Properties dialog box. 
For more information on setting the target display, see "Setting the frame 
targetÓ on page 6-11.

After inserting your links, you may want to preview your Web page to 
make sure your links are entered properly. For details on using the 
Preview mode, see "Previewing your workÓ on page 2-16. If one or more 
of your links donÕt work properly (for example, if an URL is entered 
incorrectly), follow the steps in "Repairing linksÓ on page 8-21.
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Using the desktop to insert a link

You can create links in your Web pages by using standard Drag and Drop 
techniques.

To create a link from the desktop:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 To select a portion of your text, click and drag over the desired 
area. To select a graphic, click anywhere on it once. 

3 From the desktop, click on the Þle to be linked to, then drag the 
Þle onto the selected area in Visual Page. 

Visual Page creates the link.

Using the Hyperlink button

To create a link using the Hyperlink button:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the object to be linked.

3 Select the Hyperlink button in the main toolbar. The Link dialog 
box appears.

4 Type in the Þlename or URL of the Þle to be linked to, or click 
Browse. Use the resulting dialog box to navigate to the Þle.

5 Click OK.

Visual Page creates the link.

Using the Link To field

You can link graphics and text by entering the URL in the Link To text 
Þeld. 

To create a link with the Link To field:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the object to be linked.

3 Type in the Þlename or URL in the Link To edit box, located at the 
bottom of the main edit window.
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4 Press Enter. 

Visual Page creates the link.

Inserting and displaying anchors
In contrast to links, anchors are used to mark speciÞc locations within a 
Web page. Visual Page represents anchors with an anchor icon, in both the 
Project window and in the Web page in which they are placed. 

Note: The various link insertion techniques described in "Inserting linksÓ 
on page 4-1 may be used for anchor generation as well; for example, you 
can use the Project window to insert anchors and links.

Inserting anchors

To add an anchor to a Web page:

1 Scroll to the location you intend to mark with an anchor.

2 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

3 Insert your cursor at the desired location.

4 Click on the Insert Anchor button in the toolbar. The Anchor  
Properties dialog box appears. 

5 Name the anchor so that it is easy to Þnd in the Project window 
when you need it. 

6 After you enter a name, click OK. 

An anchor icon appears in the text. 

7 Save your Web page.

You can quickly create of anchors by selecting a word at the location 
you're linking to and then clicking the Insert Anchor button. The selection 
you made appears automatically as the name of the anchor.

Displaying anchors

You can use the Project window to display all of the anchors in your site 
folderÕs Þles. The Project window can be useful, for example, in keeping 
track of your anchors across a large Web site. 
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Coloring links

Visual Page supports customized setting of link colors. Color settings for 
normal, active, and visited links are supported. These link settings change 
the default settings for a Web page. If a user changes the link colors in their 
browser, those user-deÞned settings will override your defaults.

Setting the color for normal links

Normal links represent the color for non-active hypertext links that havenÕt 
been visited by a user within a browser-speciÞed period of time. See your 
browserÕs documentation for setting expiration dates on visited links.

For removing underlines from hyperlinks in your documents, see "Using 
the Hyperlink buttonÓ on page 4-2.
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To change the color for normal links:

1 From the toolbar, click the Page Properties button. The Page 
properties dialog box displays, as shown below.

2 In the Page properties dialog box, click the Normal Links button.

A color palette appears.

3 Select the color you want from the color palette. 

If you want a custom color, click Custom and create your color by 
clicking in the color box or by setting the Hue, Saturation, 
Lumination, and Red, Green, Blue amounts. Once youÕve created the 

Click 
here to 
change 
the 
color of 
normal 
links
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desired color, click the Add to Custom Colors button, and your 
custom color is added to the Custom colors palette area.

4 When youÕve chosen the color you want, click OK.

Setting the color for active links

Active links are hypertext links that have been clicked by a user. 
SpeciÞcally, an active link is indicated as the state between when a user 
clicks on a link and when they release the mouse button, thus indicating to 
the browser to load the linked Web page.

To change the color for active links:

1 From the toolbar, click the Page Properties button.

2 In the Page properties dialog box, click the Active Links button.

3 Select the color you want from the color palette. 

If you want a custom color, click Custom and create your color by 
clicking in the color box or by setting the Hue, Saturation, 
Lumination, and Red, Green, Blue amounts. Once youÕve created the 
desired color, click the Add to Custom Colors button, and your 
custom color is added to the Custom colors palette area.

4 When youÕve chosen the color you want, click OK.

Setting the color for visited links

Visited links are hypertext links that have been previously visited, within a 
browser-based timeframe set by the user. 

To change the color for visited links:

1 From the toolbar, click the Page properties button.

2 In the Page properties dialog box, click the Visited Links button.

3 Select the color you want from the color palette. 

If you want a custom color, click Custom and create your color by 
clicking in the color box or by setting the Hue, Saturation, 
Lumination, and Red, Green, Blue amounts. Once youÕve created the 
desired color, click the Add to Custom Colors button, and your 
custom color is added to the Custom colors palette area.

4 When youÕve chosen the color you want, click OK.
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Setting Base URLs

To help avoid breaking links when you move only one Þle or set of Þles, 
but not all the Þles on a Web site, you can use the Base URL option. The 
Base URL allows you to have moved folders still link correctly to other Þles 
that remain in the original location.

For example, say you want to move one Þle into a different directory on 
the Web server, or a new site entirely. You still want the ÞleÕs links, which 
point to other Þles on your Web site, to still work. You can set the Base 
URL option to retain the links in the Þle after youÕve moved it.

To set the Base URL for a Web page:

1 Make sure that the desired Web page is open and active, and that 
youÕre also in Edit mode. To go to Edit mode, click the Edit Page 
toolbar button.

2 Right-click in the Web page and select Page. 

The Page Properties dialog box opens.

3 In the Base URL area, type the URL for the former directory 
location of your Web page. For example,

http://cafe.symantec.com/home/.

4 Click OK. 

The Base URL is now set for your Web page.

Creating email address links
You can provide a linked email address on your Web page. When a user 
clicks a linked email address, the browser's email editor displays with the 
linked email address in the recipient address Þeld.

You can also use the Project manager to change all the email addresses in 
your Web site documents. See x-ref for more info.

To provide a linked email address:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button.

2 Create the text for the link. Most Web designers set the text for an 
email address link to the email address itself. For example, 
auser@symantec.com.

3 Select the link text.
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4 Click on the Link to: Þeld and enter the following text:

mailto:user@company.com

The user is the email address of the person being emailed and 
company.com is their Internet host.

5 Press Enter to save the link.

Note: The mailto: link is not the same as the <ADDRESS> tag. For 
information on the <ADDRESS> tag, see "Creating email address linksÓ on 
page 4-7.

Repairing links and anchors

One of the easiest ways to repair links and anchors in Visual Page is to use 
the Project Manager Links and Status tabs. For information on setting up 
your Project window, see "Repairing linksÓ on page 8-21.

What’s next

In the next chapter, we cover the many graphics-based features of Visual 
Page, including graphics insertion and alignment, setting graphic attributes, 
creation of transparent graphics, using tiled backgrounds in your Web 
pages, and creating image maps.
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Working with objects

Visual Page provides all the features you need to include objects in your 
Web site. Objects in Visual Page can be images, sound Þles, Java applets, 
or plug-ins, to name a few. This chapter covers the range of Visual PageÕs 
imaging features, including types of supported images, images alignment, 
ßowing text around images, creation of transparent images and tiled 
backgrounds, and using layers.

Inserting and deleting objects
Visual Page allows you to insert other objects, such as images, from the 
Windows Explorer. If you want the Þle to be copied rather than 
referenced, press the control key while dragging the Þle.

To insert objects into Visual Page using drag-and-drop:

1 Make sure that you are in Edit Mode.

2 Locate the object (e.g. image) you want to insert with the 
Windows Explorer.

3 Press and hold the Control key while dragging the object from 
Windows Explorer into Visual Page.

When you release the mouse and control key, the Save as dialog box 
appears.

4 Rename the object, or click OK to use the default name.

The object is added to you page.

To delete an object from a Web page:

1 Make sure that you are in Edit Mode.

2 Click on the object you want to delete. 
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A border appears around the object.

3 Press the delete key.

The object is automatically deleted from the Web page.

Note: if you are working on a Web page from a project, the object is 
automatically added to or deleted from your project, whether the project is 
open or not. For more information about adding to and deleting objects 
from projects, see ÒAdding and removing Þles and foldersÓ on page 8-7.

Supported image types
The most common image formats in use on the Web today are the GIF 
(Graphic Interchange Format) and JPEG (Joint Photographic Experts 
Group) formats. Both of these formats are supported by Visual Page. 

GIF

The GIF format is the most commonly used Web format. GIF images have 
a maximum of 256 colors per image. This low overhead and support by all 
browsers currently available make it the format of choice for most small 
images, such as icons, reduced color images, and drawings. 

JPEG

The JPEG format is primarily used for Web-based photographs, due to its 
relatively high display quality. JPEG images can contain thousands or 
millions of colors. Its main disadvantage is that its overhead is greater on 
average than equivalent GIF images.

Inserting an image
You insert images in the main edit window. The various ways of inserting 
images in Visual Page are dragging and dropping, using the toolbar or 
Insert menu, or copying and pasting an image into your Web page.

After you Þnish inserting your images, you can see how they Þt into your 
Web pageÕs layout by previewing your Web page. For information on using 
the Preview mode, see ÒPreviewing your workÓ on page 2-16.
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Dragging and dropping images

With this technique, you use a graphical view and Windows techniques to 
add images to your Web pages.

To insert an image using the Project window:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Open the Þle that contains the image you want. If the Þle is in a 
project, you must Þrst open the project. ÒOpening Web Þles within 
a projectÓ on page 8-5 for more information.

3 Drag the selected graphic from the Site Project Window to the Web 
page, and release the mouse button once you have placed the 
graphic in the desired location.

Using the toolbar or Insert menu to insert an image

With this technique, you use the toolbar or menu to add images to your 
Web pages.

To insert an image using the toolbar or menu:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 From the toolbar, click the Insert Image button. You can also chose 
Image from the Insert menu.

The Open dialog box displays:

3 Navigate to and select the image Þle that you want to insert.
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4 Click Open. The image appears in your Web page.

Copying and pasting an image

Visual Page supports standard Windows Cut, Copy, and Paste procedures 
from the main menu or with standard keyboard shortcuts.

To copy and paste an image into a Web page:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 If the Web page that you want to copy the image from isnÕt open, 
open it now.

3 Within the main edit window of the Web page that contains the 
image, single-click on the image. 

4 From the Edit menu, select Copy.

5 In the Web page that you want the graphic to be copied to, 
position the insertion point where you want the graphic to appear. 
You position the insertion point by placing the cursor over the 
desired location, and clicking once.

6 From the Edit menu, select Paste. 

The image appears in the Web page.

Aligning images
Visual Page supports HTML tags that enable you to position objects such as 
images, tables, applets, movies, or plug-ins relative to the text in your Web 
page. This allows you to center a small image within a line of text, or ßow 
text around a larger image or object. 

The Object Alignment pop-up menu on the Visual Page toolbar contains 
the alignment options Top, Bottom, Middle, Left, and Right. 

In general, you use the Þrst three alignment options (Top, Bottom and 
Middle) for small images that appear in a line of text. You use the Left and 
Right alignment options when you want to ßow a paragraph of text around 
a larger image.
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To align an image:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 From the main edit window, select the graphic you want to align.

3 Click the Object Alignment button.

The Object alignment pop-up menu displays.

4 Chose an alignment option. The graphic aligns according to your 
selection.

Flowing text around images
Visual Page provides full support for ßowing text around images. 

To flow text around images in your Web page:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select a graphic in a Web page.

3 Click on the Object Alignment button, and select Left.

4 Insert your cursor to the right of the graphic and enter a paragraph 
or two of text. When the line wraps it returns to the right edge of 
the graphic, until it reaches the bottom of the graphic. 

An example of a text block ßowing around a left-aligned graphic is shown 
below.

Left 
Graphic 
Alignment
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Setting an image's attributes
Visual Page supports a range of attributes that are contained within any 
supported image. These attributes control the height, width, function, 
alternate text, and spacing around a graphic.

To set an image's attributes:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select an image in a Web page.

From the Edit menu, select Properties, then choose Image Properties. 
Or, click the Object properties toolbar button. The Image Properties 
dialog box appears, as shown below.

3 Use the options in the Image Properties dialog box to set the 
imageÕs attributes. These attributes are described in the table 
below.
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4 Click OK. Your imageÕs settings are adjusted accordingly.

Attribute Description

Image The location and Þlename of  the image Þle.

Left SpeciÞes the size of  an imageÕs left margin 
when it is being used as a layer

Top SpeciÞes the size of  an imageÕs top margin 
when it is being used as a layer

Width The display width of  the image, in pixels.

Visual Page supports image scaling (changing an 
image's height and width). The width and height 
indicated in the Image Setting dialog box are the 
dimensions of  the image as scaled in the HTML 
Þle. The actual dimensions of  the image are 
indicated in the Original Width and Original 
Height Þelds, as described below.

Height The display height of  the image, in pixels.

Original width The width of  the source image, in pixels.

Original Height The height of  the source image, in pixels.

Horizontal The blank space to the left and right of  the image, 
in pixels. The default setting is zero.

Vertical The blank space to the top and bottom of  the 
image, in pixels. The default setting is zero.

Border Width The width of  the border around an image, in 
pixels. An image border is black and is similar to a 
frame around a painting. 

The default setting is zero, which indicates no 
border.

Image Select this option if  the image functions only as an 
image. This is the default function for images.

Has server map Check this box if  the image acts as a server-side 
image map. For more information on image maps, 
see ÒCreating and editing image mapsÓ on page 5-
13.
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Creating transparent images
Transparent images are GIFs where the background color is clear, allowing 
the color of the Web page that the GIF Þle is placed in to show through. 
Making the background color of a GIF Þle transparent is a useful technique 
when you want the image to appear as if it's embedded in the page. 

Note: GIF files can have only one transparent color.

To make an image transparent:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Right-click on the image. 

A menu appears.

3 Select Edit Transparency/Interlace. 

The image appears in its own window, and the Image Tools toolbar 
displays.

4 Select the transparency color button in the Image Tools toolbar. 

5 Click on any area of the image which contains that the color that 
you want to be transparent. 

Submit form button Select this option if  the image acts as submit 
button for a form. For more information on 
forms, see ÒCreating formsÓ on page 7-9.

Alternate text If  you type in text here, it displays in a user's 
browser if  the image doesn't load properly, or if  it 
can't be displayed by a user's browser. 

Note: The alternate text option is not for images 
that function as a form submit button.

Button name (For buttons only) The name of  the button. This is 
NOT the same as the name of  the button's source 
Þle. A CGI script uses this name as an ID. For 
more information about CGI scripts, see 
ÒCreating formsÓ on page 7-9.

Attribute Description
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The areaÕs color changes to grey.

6 Save the Þle by choosing Save from the File menu.

When the altered image is dropped into a Web page, you will see the 
background of the page in all the places the selected color Þlled before.

Creating interlaced GIFs
When your Web pages are downloaded by a userÕs browser, images usually 
appear one pixel-high line at a time. Another way of having the Þles 
download is by making them interlaced. Interlaced images download as 
Þrst a general outline of the image, and then as more image data is 
received by the browser, the details of the image come into view. Only GIF 
Þles can be interlaced.

Viewing an interlaced GIF is much like seeing a picture come into focus, 
and can be more interesting to a user. Be aware that interlaced GIFs are 
slightly larger than regular image Þles, so this will affect download time as 
well. For more information about download time of images, see 
ÒCalculating Þle transmission timesÓ on page 8-25.

To create an interlaced GIF:

1 Open your Web page.

2 Make sure that youÕre in Edit mode. To go to Edit mode, click the 
Edit Page toolbar button.

3 Right-click on the GIF you want to be interlaced. 

A menu appears.

4 Select Edit Transparency/Interlace from the menu. 

The GIF opens in its own window, and the Image Tools toolbar 
displays.

5 Click the Image Interlace button. 

The GIF is now an interlaced image.

6 Select Save from the File menu to save your changes.

Creating tiled backgrounds
Instead of using a colored or plain background behind your Web page, 
you may choose to add a tiled background Ñ tiled backgrounds can add a 
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striking visual motif to your Web pages. Visual Page provides an easy-to-
use graphic interface for doing this. 

To create a tiled background for your Web page:

1 Open your Web page. 

2 Click the Page Properties button in the toolbar. 

The Page Properties dialog box appears, as shown below.

3 Click the Background Image checkbox. 

An Open File dialog box appears. If you are changing the 
background image, click the browse directory button. 

4 Navigate to the graphic Þle you're going to use, then click Open.

Click 
here to 
select 
image to 
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A reduced-size version of the graphic appears in the Background 
Image subwindow:

5 Check the appearance of the tile on your page by clicking the 
Apply button. A graphic may look interesting by itself, but may be 
too overpowering to use as a tiled background:

6 To try another background tile, click the browse directory button 
on the old image, then repeat steps 3-5. To remove a background 
image, deselect the Background Image checkbox.

7 When you're satisÞed with the background, click OK to display it 
on your Web page.
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Creating lines
Visual Page lets you add horizontal lines to your Web pages. Lines can be 
used to break up the sections of a Web page, so that the Web page 
becomes easier to read.

Inserting a line and setting line attributes

You add lines to your Web page to provide visual breaks in your 
document, especially when you are working with large quantities of 
information. You can modify its properties at anytime, such as line 
thickness and length.

To add a line:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place your cursor where you want the line to be inserted.

3 Click the Insert Line toolbar button. A horizontal line appears in 
the Web page.

To set a line's attributes:

1 Select a line by single-clicking it.

2 From the Edit menu, select Properties, and choose Line Properties. 
The Line Properties dialog box appears.

3 Use the attributes in the Line Properties dialog box to set the ruleÕs 
attributes. These attributes are described in the table below.

If you 
insert a 
line as a 
layer, the 
Left and 
Top 
properties 
can be 
modified
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4 Click OK. The horizontal line displays accordingly.

Note: The alignment attribute overrides the alignment of the line's 
paragraph. For example, if the line is center aligned and the lineÕs 
paragraph is set to left alignment, the line becomes center-aligned.

Creating and editing image maps
Unlike a block of text, an image can have more than one link associated 
with it. An example of such an image might be a picture of a map where 
each name on the map is linked to additional information about that map 
location. An image used to contain multiple linked areas is called an image 
map. 

Visual Page supports two types of image maps: client-side and server-
side.

After you Þnish creating or editing your image map, you may want to 
check the links in your image map in Preview mode, or by Control-clicking 
in Edit mode. For information on the Preview mode, see ÒPreviewing your 
workÓ on page 2-16. For details on testing and Þxing links, see ÒRepairing 
linksÓ on page 8-21.

Attribute Description

Top Size of  the lineÕs top margin when used as a 
layer

Left Size of  the lineÕs left margin when used as a 
layer

Width Width of  the line, in pixels or as a percentage of  
the line's container width (a table cell or the whole 
Web page). 

Height Height of  the line, in pixels.

Alignment Alignment of  the line (left, center, or right).

3D Shading Indicates whether or not to apply 3D shading to 
the line. The default is selected, which indicates 
that the line is shaded.
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Creating client-side image maps

Client-side image maps store the coordinates that deÞne the clickable areas 
of an image map within the HTML Þle. As such, the image map can be 
downloaded to a userÕs browser and referenced entirely from the userÕs 
machine (hence the name client-side). For a client-side image map to work 
properly, it must be within an HTML Þle.

To create a client-side image map:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button.

2 Open or create a new Web page.

3 Insert a graphic by clicking the Insert Images icon in the toolbar. 
For information on inserting images, see ÒInserting an imageÓ on 
page 5-2.

4 Right-click on the graphic. A menu appears.

5 Select Local Map Tools from the menu, if it is not already checked. 

The Image Tools toolbar displays.

6 Create the clickable areas of the image by doing the following:

a Click either the rectangle, circle, or polygon Hotspot buttons on 
the Image Tools toolbar. 

b Click and drag on the image to create a hotspot area.

c To end creating a polygon hotspot, double-click. To end creating 
a circle or rectangle hotspot, release the mouse button. 

d (optional) To make the shapes easier to see, specify the color of 
these areas by choosing the desired color from the color menu 
button.

e (optional) You may also use the Zoom buttons to adjust the 
graphic to the optimal size for outlining links. 

f Create the URL for each of the clickable areas. You can do this by 
either dragging a Þle or anchor icon from the Project window 
onto the selected link area, typing the link address into the Link 
To Þeld at the bottom of the main edit window, or right-clicking 
on the desired link location to open the Link dialog box. 

g To delete hotspot areas, select the hotspot area, and press Delete.

7 To save your client-side image map, select Save from the File 
menu. 
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Creating server-side image maps

Visual Page also supports creation of server-side image maps. While 
Symantec recommends using client-side image maps because they are 
faster to process, if your Web server or browser software doesnÕt support 
client-side image maps, you may want to use this feature.

Before you create the server-side image map, Þrst set the image map Þle 
format.

Note: Before you start creating a server-side image map, check with your 
System Administrator or Internet Service Provider (ISP) as to whether your 
Web server supports image map Þles in the CERN or NCSA format.

To set the image map file format:

1 From the Edit menu, select Preferences. 

The Preferences dialog box opens.

2 Select the HTML tab, as shown below.

3 Select the image map format that you want: CERN or NCSA.

4 Click OK to close the dialog box.

To create a server-side image map:

1 Open the image Þle in Visual Page.
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2 Use the Image tools (rectangle, circle, polygon) to outline the parts 
of the image you want to use as links. 

3 (optional) To make the shapes easier to see, specify the color of 
these areas by choosing the desired color from the color menu 
button.

4 To create a link, drag a Þle or anchor icon onto the selected link 
area, or type the URL into the Link To Þeld at the bottom of the 
main edit window.

5 Once you have inserted the links for your image map, save it by 
choosing Save from the File menu. 

Once the image map is saved, Visual Page generates the image mapÕs 
.map Þle, and places it in the same folder as your image Þle.

To activate a server-side image map, you need to upload the image and its 
.map Þle to a Web server. Contact your System Administrator or Internet 
Service Provider for more details.

Understanding layers
HTML has been traditionally used for publishing documents over the 
Internet. However, using standard HTML has not been robust enough to 
design and create interactive and multimedia-enhanced Web pages that 
many Web sites need. 

When you work with layers, you are working with one or more sections of 
a Web page. When you make a layer, you are creating an object. An object, 
like an image or plugin, can be moved around a Web page to an exact 
pixel location. These objects can be contained within containers. 
Containers contain all sorts of objects, such as images, applets, and even 
text. Containers can be inserted as an object into a Web page, or inserted 
as a layer. You can modify the contents of a container at anytime.

Netscape and Microsoft have different implementations of layers. Visual 
Page makes accessible the layer attributes and properties that are common 
to both browsers. When you have the most common layer attributes in 
your Web documents, your documents are more portable.

Using layers allows you to create much more dynamic Web pages. With 
layering, it is possible for text to overlap, background images to be aligned 
with the foreground without using complicated frames or tables, and 
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information can be efÞciently organized within groups instead of only in a 
table. 

Absolute positioning

Absolute positioning enables more design ßexibility and display accuracy. 
For example, absolute positioning enables content, such as text, images, 
and anything else that can be put in a page, to be positioned at exact 
coordinates. 

Absolute positioning also enables a Web author to animate page objects. 
Blocks of absolutely-positioned objects can be hidden, shown, and moved 
about the page. You can design and implement your pages so that they 
could detect a user selecting a piece of content from a menu and highlight 
it.

Note: Consult your Web browserÕs documentation to see which tags are 
supported in each.

The Layer toolbar

You create layers with the Layer Editor, which has its own ßoating toolbar. 
To access the Layer ßoating toolbar, select Layer Tools from the Layer 
menu. When it is selected, there is a check mark in front of the menu item. 
You can dock the Layer toolbar by dragging it to a position on the main 
toolbar. To undock it, drag the Layer toolbar to anywhere on the desktop.

You can toggle between the Layer Editor and the Visual Page Text Editor 
by using the two leftmost buttons on the Layer Toolbar. When you are in 
Layer editing mode, you are working with objects on a page. When you 
insert objects while in layer mode, the objects are inserted as layers.

Layer 
mode

Text 
mode

Convert 
to layer

Align 
left 
edges

Align 
right 
edges

Align top 
edges

Align 
bottom 
edges

Space 
evenly, 
vertically

Space 
evenly, 
horizontally

Move to 
front

Move to 
back

View 
grid
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When you switch to text editing mode, you can edit properties within each 
object, such as changing fonts and point sizes. In either mode, Visual Page 
functionality such as changing colors and applying fonts is available.

Note: Whenever you select an object, Visual Page automatically switches 
to Layer mode.

Creating layers
This section describes creating and working with layers: 

n Creating layers

n Working with containers

n Creating layers from objects on your Web page

n Positioning layers on your Web page

You can create a layer at anytime by selecting an object and then 
converting it to a layer.

To create a layer from objects in a page:

1 You must have a Web document open in the Visual Page editor.

2 Switch to Layer mode by clicking the Layer Mode icon.

3 From the Insert Þle menu, or from the Visual Page toolbar, select 
an object to insert.

The object is inserted as a layer into the Web page.

or

4 Highlight or select an object or text that you want to use as a layer.

5 Choose Convert to Layer from the Visual Page Layer menu. 

The selected object becomes a layer.
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Inserting containers

Containers are holders of texts and objects. You can group objects together 
to act as a single layer, or to have different objects act as separate layers.

You insert an empty container into your Web page and create, add, or 
modify the contents. Then, you turn it into a layer from the Layer menu. 
You can manipulate this layer like any other.

You can also put a container in a Web page and place other layers inside it.

To insert an empty container:

1 Select Layer mode from the Layer toolbar if you are not in Layer 
mode.

2 Position your cursor where you want to insert the empty container.

3 From the Insert menu, select Container.

A new container is inserted into the page.

To delete a container

1 Select Layer mode from the Layer toolbar.

2 Select the container to be deleted.

3 Press the delete key.

The selected container and its contents are deleted.

Changing container properties

You can set pixel positioning and color properties through the Container 
Properties dialog box.
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To change container properties:

1 Right-click in a container and select Container Properties from the 
pop-up menu.

The Container Properties dialog box appears:

2 Modify the properties as needed.

3 Click OK to apply the changes and close the dialog box.

Note: if you did not convert your container to a layer, only the Width and 
Height properties can be modiÞed.

Positioning layers

After creating a layer or several layers, you can position them freely around 
your Web page. You can position layers to overlap with each other, align 
edges, or snap them to grid.

Note: If you have difÞculty looking at the following illustrations in this 
book, refer to the same pages as in the PDF version of this book for color 
illustrations.

To position a layer in a Web page:

n Click in the layer and drag it to a new position in the page.

The Left and 
Top properties 
are only 
modifiable after 
you’ve 
converted the 
container to a 
layer
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For more information, see ÒSetting layer grid spacingÓ on page 5-29.

You can also use the arrow keys to position the selected layer(s).

Click in the 
layer and drag 
it to a new 
location
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To position a layer back to its original position:

n Select Undo from the Edit Þle menu.

Positioning layers to front or back

When you are working with more than one layer, you can position them to 
the front or back. When you position a layer to the front, it becomes the 
foremost visible object. When you position it to back, it is behind all other 
layered objects.

To position a layer to the front:

1 Select the Layer you want to move to front view:

2 Click the Move to Front icon on the Layer toolbar.

This layer is behind 
another one

This layer is the 
foremost layer
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The selected layer is moved to front view.

To position a layer behind another object

1 Click the Layer Mode toolbar button to work in Layer Mode

2 Select the Layer you want to position to behind another layer.

3 Click the Move to Back icon on the Layer toolbar.

This layer is no 
longer the 
foremost layer

This layer has 
been moved to 
the foremost 
view

In this example, 
this foremost layer 
is going to be 
moved to the back
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The selected layer is moved behind the other object(s):

Positioning layers forward and backward

When you are working with more than two or more layers, you can 
change the ordered position of a selected layer by positioning it forward or 
backward.

To position a layer forward:

1 Select a layer that you want to move forward.

2 From the Layer menu, select Move Forward.

The selected 
layer is now 
moved behind all 
other layers

In this 
example, this 
layer is 
behind all 
others, and 
will be moved 
one position 
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The selected layer moves forward one position:

To position a layer backward:

1 Select a layer that you want to position backward.

2 From the Layer menu, select Move backward.

Layer 4 has 
been moved 
one position 
forward

This layer is 
the foremost 
and will be 
moved back 
one position
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The selected layer is positioned backward:

Resizing layers

After you create a layer, you can resize it easily by grabbing a corner or 
side and dragging it to a desired size. The contents of the layer are static.

To resize a layer:

1 Click on a side or corner of the layer. 

A black outline of the layer container appears.

2 Grab a side or corner of the layer and drag it to the desired size.

Aligning layers

The Visual Page Layer Editor can align your layered objects to the same 
axis for you. You must select two or more layers to activate the Alignment 
features. If you want to align all the layers, use the Control + A keys 
combination to select all the layers in the page.

If you want to select certain layers to align, Shift-click on individual layers.
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Left edges

Aligns selected layers with the edge of the leftmost selected layer.

To align layers to left edges:

1 Position the leftmost layer so that its left side becomes the 
alignment axis for other objects.

2 Select the layers to be aligned.

3 Click the Align Left icon on the Layer toolbar.

The selected layers are aligned to the left side of the leftmost selected 
layer.

Top edges

Aligns selected layers to their top edges with respect to the topmost 
selected layer.

To align layers to top edges:

1 You must be in Layer Mode.

2 Position the topmost layer so that its top side becomes the 
alignment axis for other selected objects.

3 Select the layers to be aligned.

4 Click the Align Top icon on the Layer toolbar.

The selected layers are aligned to the top side of the highest selected 
layer.

Right edges

Aligns selected layers to their right edges with respect to the righmost 
layer.

To align layers to right edges:

1 You must be in Layer Mode.

2 Position the rightmost layer so that its right side becomes the 
alignment axis for other selected objects.

3 Select the layers to be aligned.

4 Click the Align Right icon on the Layer toolbar.
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The selected layers are aligned to the right side of the right-most 
selected layer.

Bottom edges

Aligns selected layers to their bottom edges with respect to the lowest 
positioned layer.

To align layers to bottom edges:

1 You must be in Layer Mode. Click the Layer Mode icon on the 
Layer toolbar to work in Layer Mode.

2 Position the lowest layer so that its lowest side becomes the 
alignment axis for other selected objects.

3 Select the layers to be aligned.

4 Click the Align Bottom icon on the Layer toolbar.

The selected layers are aligned to the lowest side of the lowest 
selected layer.

Align to grid

If you work with the Grid feature turned on, the grid helps align your 
objects.

To align layers to grid:

You must be in Layer Mode. Click the Layer Mode icon on the Layer 
toolbar to work in Layer Mode.

1 You must have the Grid turned on and conÞgured. To turn on and 
conÞgure the grid, see ÒSetting layer grid spacingÓ on page 5-29.

2 Select the objects that you want to align with the grid.

3 From the Layer menu, select Align, then To Grid.

The selected objects are aligned to grid:

Spacing layers evenly

When you select two or more layers, you can evenly space them 
horizontally or vertically.
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To space layers evenly:

1 Select the layers you want to space evenly.

2 Select Space Horizontally or Vertically from the Layer toolbar.

The selected objects are evenly spaced.

Deleting layers

You can easily delete one or more layers from your Web page.

To delete a layer:

1 Select one or more layers in the open Web page. 

A black border surrounds the layer(s).

2 Press the delete key. 

Visual Page deletes the selected layer(s).

Setting layer grid spacing

The Layer Þle menu contains all the functionality of the Layer toolbar plus 
the option of setting grid spacing.

To change layer grid spacing:

1 Select Layer Mode from the Layer Toolbar if you are not in Layer 
mode. 

The grid appears.

2 Choose Grid Options from the Layer Þle menu. 

The Grid Options dialog box appears:
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3 To have larger grid spacing, set the numbers higher than the 
default. For smaller, ÒtighterÓ grids, reduce the number of pixels. 
Set the number of pixels to 0 for no grid.

4 Click OK. 

The Grid Options dialog box closes and the grid is reset.

What’s next
In the next chapter, we explore Visual PageÕs tools for creating and 
manipulating frames and tables.

Grid option Description

Show Grid Displays grid

Snap to Grid Places objects to closest grid line

Grid Spacing Width: increase number for larger horizontal 
spacing

Height: increase number for larger vertical 
spacing
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Using frame sets and tables

This chapter covers the range of tools that Visual Page provides for the 
creation and editing of frame sets and tables, including resizing and 
splitting of frames, insertion and deletion of rows and columns, resizing of 
tables, and selection/manipulation of multiple cells.

Creating frame sets
A frame set consists of two or more independent parts (called frames). 
All frames contain a single HTML Þle within its borders Ñ as such, a frame 
set is essentially a Web page that contains multiple Web pages. Frames can 
be scrolled, resized, or have their contents replaced dynamically. 
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An example of a frame set is shown below. 
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To create a frame set:

1 Choose New Frame Set from the File menu (or press Shift-Ctrl-N). 
A frame set with two frames of equal size displays.

2 Choose Save Frame Set from the File menu (or press Ctrl-S). The 
Save As dialog box appears.

3 Navigate to the folder where you want to save the main frame, 
enter a name for the frame set, and click Save.
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Now that youÕve got your frame set started, you can add text (see Chapter 
3 for details), insert graphics (as explained in Chapter 5), tables (see 
ÒInserting tablesÓ on page 6-13 for details), and advanced features Ñ such 
as plug-ins, Java applets, JavaScript code, or forms (described in Chapter 
7). If you want to preview your document, or view its HTML source code, 
be sure to see the sections covering preview and source code modes in 
Chapter 2.

When you save your frame set again, youÕll be prompted to save the Web 
pages within your frame set:

1 Choose Save Frame Set from the File menu. 

A Save Frame As dialog box displays, allowing you to save the left 
hand frame Þle. 

2 Enter a name for the frame Þle and click Save.

A second Þle save dialog box displays, this time for saving the right 
hand frame Þle. 

Click the 
left frame 
to save it
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3 Enter a name for the frame Þle and click Save.

While it is possible to save the Web pages in the left and right-hand frames 
to a different location than the frame set, it will be easier for you to track 
and maintain all three Þles if they are in one folder, with similar names. For 
example, you may want to name the frame set main.html, the Web page 
in the left-hand frame lframe.html, and the Web page in the right-hand 
frame rframe.html.

After you Þnish creating your frame set, you may want go into Preview 
mode, in order to see how your frame set looks. 

Click 
the right 
frame 
to save 
it
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Changing a frame's Web page

Visual Page lets you replace the Web page contained within a frame with 
another Web page. You can use an existing Web page, if you want.

To change the Web page displayed in a frame:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the frame to be replaced by single-clicking anywhere within 
the frame.

3 Choose Set Frame Source from the Frame menu. 

An Open dialog box appears:

4 Navigate to and select the new Þle that will display in the frame.

5 Click Open. 

Visual Page displays the new Web page inside the frame. The new 
Web page is a reference and not inserted into the frame.
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Displaying a frame-based Web page in its own window

Visual Page allows you to display the Web page contained within a frame 
in its own window. This can be useful when you want to edit the frame 
Þle, but have more space to work in.

To open a frame-based Web page in its own window:

1 From the main editing window, select a frame Þle by single-
clicking anywhere within a frame in a frame set.

2 Choose Open in New Window from the Frame menu.

The Web page opens in its own window.

Setting a frame's attributes

Visual Page supports a range of attributes that are contained within any 
frame. 

To set a frame's attributes:

1 Right-click in a frame and select Show Frame Properties. 
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The Frame Properties dialog box displays:

2 Use the options in the Frame Properties dialog box to set the 
frameÕs attributes. These attributes are described in the table 
below.

3 Close the Frame Properties dialog box by clicking on the Close 
Window button (an X in the upper-right corner).

The frame attributes are deÞned below:

Attribute Definition

Source The HTML source Þle for a frame.

Set to zero for 
borderless frames
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Modifying frames

Visual Page has several features for modifying frames, including changing a 
frameÕs size, removing a frame from a Web page, and splitting a frame into 
two sections.

Changing a frame's size

Resizing of a frame is controlled with the resize bar (shown at left). The 
resize bar appears automatically when you place the cursor over the 
border between frames while in Edit mode.

Frame title The frame's name. This is NOT the same as the 
name of  the source Þle. The frameset Þle (the Þle 
that contains the frames within a frame set) uses 
this name as an ID.

Frame width The width of  the selected frame, either as a 
percentage of  the total frame set, or in pixels.

Frameset height The height of  the frame set, either as a percentage 
of  the total frame set, or in pixels.

Margin width The width of  the selected frame's margin, in 
pixels.

Margin height The height of  the selected frame's margin, in 
pixels.

Show scrollbar The settings for the frame's scroll bars. Possible 
choices are Yes, No, and Auto. The default is 
Auto, which makes the scroll bars appear only 
when the frame content is larger than the frame 
itself.

Resizable frame Indicates whether or not the user can resize the 
frame in the browser.

Frameset Border Indicates the size of  the borders around frames. 
Leave this box empty for a default border, or set 
to 0 (zero) for borderless frames.

Attribute Definition
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To resize a frame:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Adjust the frameÕs size with the resize bar, or choose Show Frame 
Properties from the Edit menu and enter the desired width in the 
Width Þeld.

For more information about the Width Þeld, see ÒSetting a frame's 
attributesÓ on page 6-7.

Removing a frame

Visual Page lets you remove a frame from within a frame set.

Note: Removing a frame doesn't delete the frame Þle contained within the 
frame, only the frame itself.

To remove a frame:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the frame to be removed.

3 Choose Remove Frame from the Frame menu.

The frame disappears from the frame set.

Splitting frames

Visual Page lets you split a frame into two equal parts, either horizontally 
or vertically.

To split a frame:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select the frame to be split.

3 Choose either Split Frame Vertically or Split Frame Horizontally 
from the Frame menu. The frame divides accordingly into two 
frames.
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Using the No Frames window

The No Frames window lets you specify what to display when a user's 
browser doesn't support frames. This lets the content of your Web Þles still 
be viewed by users, even when their browsers donÕt support frames.

To use the No Frames window:

1 Open a frame-based Web page.

2 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

3 Choose No Frames Page from the Frame menu. The No Frames 
dialog box displays.

4 Enter the content to be displayed.

5 Close the No Frames window. 

6 From the File menu, choose Save Frame Set. 

Your No Frames information is saved.

To view or edit content that you've entered into the No Frames window, 
choose No Frames Source from the Frame menu. The No Frames window 
appears, letting you edit the No Frames contents.

Setting the frame target

Visual Page provides a feature that you can use to select a base target for 
all the links in a frame. A base target is the frame in which a linked Þle 
displays. For instance, you could use this feature to direct all the hypertext 
links in a left-hand frame to appear in the neighboring right-hand frame. 

To set a base target for the links in a frame:

1 Open a frame set, and make sure the frame is already named and 
saved.

2 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

3 Select a frame by single-clicking in it. 

4 Select Properties from the Edit menu and choose Page. 
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The Page Properties dialog box displays, as shown below. 

5 Click the Select Base Target button. 

The Base Target dialog box opens, as shown below.

6 Click a frame in the reduced-size version of your frame set to 
designate it as a base target. 

You can also set any link in any frame to a different target. The Base Target 
dialog is accessible from the Link To dialog box when the link is inside a 
frame.

Click here 
to open 
the base 
target 
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You can set the Base Target with the following options:

7 (optional) If you want to set the base target for another frame in 
your frame set, go through step 6 again for each frame.

8 Click OK to set the base target for the selected frame. 

Creating tables
Like frames, tables increase the design options for Web-based content. 
Unlike frames, tables display content in a grid-based format, allowing 
control over single elements within the table cells), as well as the 
formatting of the entire table. This section covers how to format and 
modify tables, including inserting tables, editing single cells, multiple cells, 
and entire tables, and setting of attributes for tables and their cells.

Inserting tables

To add a table to your Web page:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Position the insertion point where you want the table to appear. 
You position the insertion point by putting your cursor in the 
desired location, and clicking once.

Base Target option Description

Default Makes the linked Þle display in the same frame as 
the current frame Þle. This is the default setting. 
How the default setting performs depends on 
each browserÕs conÞguration.

New window Makes the linked Þle display in a new, window.

Same frame Makes the linked Þle display in the same frame as 
the current frame Þle.

Same window Makes the linked Þle display in the same window 
as the current frame Þle.

Parent window Makes the linked Þle display in the parent window 
of  the current frame Þle. The parent window is 
the window that was active, then a link opened 
which caused the current frame Þle to display.
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3 Click the Insert Table toolbar button (shown at left). 

The Table Properties dialog box displays:

4 Set the number of rows and columns for your table. For 
information about setting attributes for a table, see ÒSetting table 
attributesÓ on page 6-20.

5 Close the Table Properties dialog box by clicking on the close 
button (an X in the upper-right corner). 

Editing tables

Visual Page provides an extensive set of tools for the editing of tables in 
your Web pages, including multiple cell selection and editing, insertion 
deletion, and resizing of rows and columns, and spanning of rows and 
columns.

Selecting and editing multiple cells

Visual Page allows selection and editing of multiple adjacent cells. 

To select multiple cells:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select a set of multiple adjacent cells:
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TIP: You can click and drag over a group of cells to select a block of cells. 
To select or des-select individual cells, Control-click in the cell.

3 Perform the editing task or tasks that you want to execute on the 
selected cells. Any selected set of cells may have the following 
changes applied to them:
n Paragraph formatting (see ÒApplying paragraph stylesÓ on page 

3-4 for more information)
n Paragraph alignment (see ÒApplying paragraph alignment 

attributesÓ on page 3-6 for more information)
n Character formatting (see ÒFormatting charactersÓ on page 3-7 

for more information)
n Deleting multiple rows or columns (see ÒDeleting rows and 

columnsÓ on page 6-16 for more information)
n Setting cell attributes (see ÒSetting cell attributesÓ on page 6-22 

for more information).

Inserting rows and columns

Visual Page supports insertion of rows and columns into existing HTML 
tables. 

To insert a row into a table:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place the cursor where you want the row to be inserted in the 
table. 

3 Click the Insert Row button in the main toolbar.
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A new row appears above the current row.

To insert a column into a table:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place the cursor where you want the column to be inserted in the 
table.

3 Click the Insert Column button in the main toolbar.

A new column appears to the left of the current column.

Deleting rows and columns

Visual Page supports the deletion of rows and columns from existing 
HTML tables. 

To delete a row from a table:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place the cursor anywhere within the row to be deleted, or select a 
set of rows to be deleted.

3 Click the Delete Row button in the main toolbar.

The rows disappear.

To delete a column from a table:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place the cursor anywhere within the column to be deleted, or 
select a set of columns to be deleted.

3 Click the Delete Column button in the main toolbar.

The columns disappear.

Spanning rows and columns

You can use Visual Page to extend a cell across a number of rows or 
columns. This allows you to create tables with asymmetrical cell 
placement, such as a cell that spans two rows and two columns. 
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To set a cell to span across multiple rows and/or columns:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Click on the cell that you want to enlarge.

3 From the Edit menu, select Properties, then choose Table 
Properties. 

The Table Properties dialog box displays.

4 Click on the Cells Tab.

5 Within the Span across columns Þeld, enter the number of 
columns that you want the cell to span.

6 Within the Span down rows Þeld, enter the number of rows that 
you want the cell to span.

7 Close the Table Properties dialog box by clicking on the close 
button (an X in the upper-right corner).

An example of a table with a spanned cell is shown below.

Resizing rows and columns

You can resize one or more rows and columns within Visual Page. 

To resize a row or column:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place the pointer over the border of the row or column you want 
to resize. The pointer changes to a resizing cursor.

3 Click on the row or column's border and hold the mouse button 
down.

4 Drag the mouse until the row or column is resized to the desired 
dimensions.
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5 Release the mouse button. 

The row or column remains according to the revised dimensions.

Resizing tables

In addition to resizing rows and columns, you can resize an entire table. 

To resize a table:

1 If youÕre not in Edit mode, switch to this mode by clicking Edit 
Page toolbar button. 

2 Select the table to be resized by clicking anywhere within the 
table.

3 Click on a resizing handle (the square boxes that appear around 
the edge of the table) and hold the mouse button down.

4 Drag the mouse until the table is resized.

5 Release the mouse button.

Adding color to tables

You can use Visual Page to set the background color of an entire table or 
the background color of one or more cells. This can be used to distinguish 
individual subsections (groups of cells) within a row or column, for 
example.

To change a table's background color:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select a table by clicking anywhere within the table.
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3 From the Edit menu, select Properties, and then choose Table 
properties. The Table Properties dialog box appears:

For more information about the Table Properties dialog box, see 
ÒSetting table attributesÓ on page 6-20.

4 Click the Table tab.

5 Click the Background Color button. 

A color palette appears.

6 Select the color you want from the color palette. 

If you want a custom color, click Custom and create your color by 
clicking in the color box or by setting the Hue, Saturation, 
Lumination, and Red, Green, Blue amounts. Once youÕve created the 
desired color, click the Add to Custom Colors button, and your 
custom color is added to the Custom colors palette area.

7 When youÕve chosen the color you want, click OK.

To change a cell's background color:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select one or more cells.

3 From the Edit menu, select Properties, and then choose Table 
properties. 

Click here to 
change 
background 
and cell colors
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The Table Properties dialog box appears. 

For more information about the Table Properties dialog box, see 
ÒSetting table attributesÓ on page 6-20.

4 Click the Cells Tab.

5 Click the button next to Cell background color. 

A color palette appears.

If you want a custom color, click Custom and create your color by 
clicking in the color box or by setting the Hue, Saturation, 
Lumination, and Red, Green, Blue amounts. Once youÕve created the 
desired color, click the Add to Custom Colors button, and your 
custom color is added to the Custom colors palette area. Click OK to 
close the color palette.

6 Click on the color you want. 

The color palette closes.

7 To close the Table Properties dialog box, click on the close button 
(the X in the upper-right corner).

Setting table attributes

Visual Page supports a range of table attributes, including the number of 
rows and columns as well as row and column dimensions. 

To edit a table's attributes:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select a table by clicking anywhere within the table.

3 From the Edit menu, select Properties, and then choose Table 
properties. 
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The Table Properties dialog box appears:

4 Click the Table tab to display the attributes for the entire table. For 
information on setting attributes for individual cells, see ÒSetting 
table attributesÓ on page 6-20. These attributes are described in the 
table below.

Attributes Description

Number of  rows The number of  rows in the table.

Number of  columns The number of  columns in the table.

Space around text The margin around a cellÕs text, in pixels.

Space between cells The margin between each cell, in pixels.

Width The width of  the selected table. This value is 
either a percentage of  the total container width (a 
window, frame or another table cell), in pixels, or 
is set automatically by Visual Page. When set to 
auto, Visual Page adjusts the width in proportion 
to the table's content.
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5 Close the Table Properties dialog box by clicking on the close 
button (an X in the upper-right corner)

Setting cell attributes

Note: Except for Span Rows and Span Columns, all of the settings below 
apply to multiple cell selection as well as to selection of individual cells.

Visual Page supports a range of features for individual cell manipulation, 
such as cell dimensions and cell background color. 

To edit a cell's attributes:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select a cell or range of cells within a table. 

3 From the Edit menu, select Properties, and then choose Table 
properties. 

The Table Properties dialog box appears:

Table's height The height of  the selected table. This value is 
either a percentage of  the total container height 
(window or frame), in pixels, or is set 
automatically by Visual Page. When set to auto, 
Visual Page adjusts the height in proportion to the 
table's content.

Border width The width of  the table's border, in pixels. A 
setting of  0 indicates no border.

Caption placement The caption above or below the table's body. The 
default is set to None, indicating that the table 
doesn't have a caption.

Background color The background color of  the table. The 
default is for no color to display. For more 
information, see ÒAdding color to tablesÓ 
on page 6-18.

Attributes Description
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4 Click the Cell tab to display the attributes for the selected cells, as 
shown below:

5 Use the cell options displayed in the Cell Properties dialog box to 
set the attributes of the selected cell(s). These attributes are 
described in the table below.

Attributes Description

Row and column dimensions Sets column width and height by percentage 
or pixel amount.

Width The width of  the selected cellsÕ column, 
either as a percentage of  the table's width, in 
pixels, or as set automatically by Visual 
Page. When set to auto, Visual Page adjusts 
the width in proportion to the column's 
content.

Height The height of  the selected cellsÕ row, either 
in pixels or as set automatically by Visual 
Page. When set to auto, Visual Page adjusts 
the width in proportion to the row's content.
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6 Close the Table Properties dialog box by clicking on the close 
button (an X in the upper-right corner).

What’s next
In the next chapter, we cover Visual PageÕs advanced features Ñ inserting 
plugins and Java applets, using JavaScript, and incorporating forms into 
your Web pages.

Span across columns Spans the cell across the indicated number 
of  columns. Default is set to 1. For more 
information, see ÒSpanning rows and columnsÓ 
on page 6-16.

Span down rows Spans the cell across the indicated number 
of  rows. Default is set to 1. For more 
information, see ÒSpanning rows and columnsÓ 
on page 6-16.

Vertical alignment The vertical alignment of  the selected cell's 
contents. The default is to align the cell's 
contents in the vertical center of  the cell.

Header style Indicates whether or not to apply the 
Header table tag (centered bold format) to 
the active cell's contents. The default is set to 
unchecked, indicating that the header style 
is not applied.

Wrap lines Indicates whether or not to apply line 
wrapping to the selected cell's contents. 
Default is set to checked, indicating that line 
wrapping is applied.

Background color The color of  the selected cell(s). The default 
is for no color to display. For more 
information, see ÒAdding color to tablesÓ on page 
6-18.

Attributes Description
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Adding programming 
features

This chapter covers the advanced features of Visual Page, including placing 
plugin media and applets into your Web pages, integrating JavaScript with 
your Web pages, creating forms with Visual Page, integrating CGI scripts 
with your forms, and adding database connectivity to your Web pages.

Inserting plugins and applets
Visual Page provides integrated support for plugins and applets Ñ placing 
audio, video and streaming media (audio, video, or graphics that have 
been optimized for fast transmission across the Web) is effortless. 

Be sure to preview your Web page after inserting a plugin or applet, to 
ensure that the plugin or applet is placed properly in the page. For details 
on using the Preview mode, see ÒPreviewing your workÓ on page 2-16.

Inserting plugins

To insert a plugin:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Position the insertion point by placing the cursor over the desired 
insertion point and single-clicking.

3 In the toolbar, click the Insert PlugIn button.

4 Navigate to and select the plugin Þle that you want to insert.

5 Click OK. 
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The plugin is now inserted.

You can also drag and drop plugins from the Local Site window, if your 
global preferences are set to display all Þles from within the Local Site 
window. For information about setting the global preferences, see ÒSetting 
global preferencesÓ on page 2-7.

To drag and drop a plugin:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Open a Local Site window for the folder that contains the plugin 
by selecting Open Local Site from the File menu. For information 
on setting up your Local Site window, see ÒUnderstanding 
projectsÓ on page 8-2.

3 Within the Local Site window, select the Þlename for the plugin by 
clicking it once. 

4 Drag the selected plugin from the Local Site window to the Web 
page, and release the mouse button where you want the plugin to 
appear.

The plugin appears in the Web page.
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Setting plugin attributes

You can modify properties of all plugins in your Web page.

To modify a plugin’s attributes:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Double-click on the plugin. The Plugin Properties dialog box 
appears, as shown below.

3 Use the options in the Plugin Properties dialog box to set the 
pluginÕs attributes. These attributes are described in the table 
below.

4 Click OK.

Attribute Description

Location The folder containing the plugin.

Name The name of  the plugin. 

Left Sets the left margin of  the plugin when used 
as a layer
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Note: The creation and editing of plugin content needs to be done within 
the appropriate plugin utility and/or pertinent software packages. 

Inserting applets

To insert an applet:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Position the insertion point where you want the plugin to appear. 
Do this by placing the cursor over the desired insertion point and 
clicking the mouse button once.

3 Click the Insert Java Applet toolbar button (shown at left).

4 Navigate to and select the applet Þle that you want to insert.

5 Click OK. 

The applet is now in your Web page.

Note: Applets run only in the Preview mode. 

You can also drag and drop applets from the Local Site window, if your 
global preferences are set to display all Þles from within the Local Site 
window. For information about setting the global preferences, see ÒSetting 
global preferencesÓ on page 2-7.

Top Sets the top margin of  the plugin when used 
as a layer

Width The width of  the plugin, in pixels.

Height The height of  the plugin, in pixels.

Horizontal Space around The horizontal blank space around the plugin, in 
pixels.

Vertical Space around The horizontal blank space around the plugin, in 
pixels.

Parameters Customized parameters of  the plugin (if  any), and 
their respective values.

Attribute Description
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To drag and drop an applet:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Open a Local Site window for the folder that contains the plugin 
by selecting Open Local Site from the File menu. For information 
on setting up your Local Site window, see ÒUnderstanding 
projectsÓ on page 8-2.

3 Within the Local Site window, select the applet Þle by clicking the 
ÞleÕs icon. 

4 Drag the selected applet from the Local Site window to the Web 
page, and release the mouse button where you want the applet to 
appear. The applet is now part of your Web page.

Setting applet attributes

To modify the parameters of an applet:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Double-click on the applet. 

The Java Applet Properties dialog box appears, as shown below:
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3 Use the options in the Applet Properties dialog box to set the 
appletÕs attributes. These attributes are described in the table 
below.

4 Click OK.

Note: For information on creating custom parameters, consult the Java 
documentation for the applet class.

Visual Page's Java console

If your Web pages include Java applets, you may need to use the Java 
console. The Java console is commonly used as the output window for a 
Java applet Ñ when you run an applet in Visual Page, the place that 
runtime output commonly displays is in the Java console.

Attribute Description

Location The folder containing the applet.

Name The name of  the applet. 

Left Sets the left margin when applet is used as a 
layer

Top Sets the top margin when applet is used as a 
layer

Width The width of  the applet, in pixels.

Height The height of  the applet, in pixels.

Horizontal Space around The horizontal blank space around the applet, in 
pixels.

Vertical Space around The horizontal blank space around the applet, in 
pixels.

Parameters Customized parameters of  the applet (if  any), and 
their respective values.
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To access the Java console:

n Choose Show Java Console from the View menu. The Java Console 
appears.

Visual Page and Visual Cafe

SymantecÕs Visual Cafe is an ideal complement to Visual Page for creating 
Web-based content. Visual Cafe includes several features that are useful to 
creating Web-based Java content, including full applet creation support, an 
easy-to-use graphical interface, and wizards for creating interactive content.

Using JavaScript
NetscapeÕs JavaScript protocol is designed for the creation of interactive 
Web pages. By integrating JavaScript code into a Web page, you can create 
pages that are designed according to a userÕs speciÞcations, storage and 
retrieval of user-based data, and a variety of other basic programming-level 
tasks. 

Note: Not all browsers support JavaScript. For details, consult the 
documentation for any browsers you plan on supporting in your Web site.

Adding JavaScript to a Web page

JavaScript code can be imbedded directly into a Web page. This cuts down 
on the overhead of maintaining a separate Þle for the JavaScript code.

To insert JavaScript code into a Web page:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Select JavaScript from the Style menu.

3 Enter your JavaScript code. 

Visual Page changes the color of the text to indicate that itÕs 
JavaScript.

4 Deselect JavaScript from the Style menu.

Visual Page inserts the beginning and ending HTML script tag (</
SCRIPT>) around the selected block in the Web page source code, as 
seen in the source editor.
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Once you've entered the requisite Javascript tags into your Web page, you 
can edit the Javascript code in Visual Page's source editor. For details on 
using the source editor, see ÒViewing the HTML codeÓ on page 2-17. 

After you Þnish inserting your JavaScript code, you preview and test the 
results of your JavaScript code in a JavaScript-enabled Web browser. 

Accessing a stand-alone JavaScript file

Saving your JavaScript codes and calling them from a Web page as you 
need them enables you to reuse JavaScript routines. For example, if you 
have a banner script that you'd like to reuse on other pages, you can save 
the JavaScript code as a separate Þle, and access it as you wish, without 
having to cut and paste the code into a Web page every time. To guarantee 
that Visual Page can Þnd your JavaScript Þles, make sure that they end with 
a .js extension.

While this method increases your Þle maintenance overhead, it also makes 
your code accessible from any Web page, without having to paste the 
JavaScript code into a Web page.

If you create a stand-alone JavaScript Þle, note that it is saved in a plain 
text (ASCII) format; as such, it can be uploaded and downloaded in the 
same manner as any other text Þle. For information on uploading and 
downloading text Þles, see ÒPublishing your projectÓ on page 8-11 and 
ÒDownloading Þles and folders from your Web serverÓ on page 8-17.

To call a JavaScript file from within a Web page:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place the cursor where you want the JavaScript call to occur.

3 Choose JavaScript Þle from the Insert menu. 

The Open dialog box displays, listing all of the Þles with a .js 
extension. 

4 Navigate to the folder containing the JavaScript Þle that you want 
to use, and select the desired JavaScript Þle.

5 Click Open.

Visual Page inserts a JavaScript icon into the Web page, along with a pair 
of <SCRIPT> tags in the Web pageÕs HTML source, using the following 
format:
7-8



Creating forms
<SCRIPT LANGUAGE "JavaScript" SOURCE="symantec.js">

</SCRIPT>

Creating forms
Forms are used for the creation of HTML-based input and processing of 
data. If youÕve ever registered for a piece of software on the Web, youÕve 
used forms: the Þelds that you enter your name, phone number, and email 
address into are all parts of a form. 

Note: Be sure to preview your Web page after inserting a form, to ensure 
that it is placed properly within the page. For details on using the Preview 
mode, see ÒPreviewing your workÓ on page 2-16.

Adding form elements to a Web page

Forms are created by including one or more form elements (such as Þelds 
and checkboxes) as part of a form structure. Visual Page includes this form 
structure for you. All you need to do is place the elements in a Web page.

Visual Page supports the standard user interface elements used in forms, 
such as radio buttons, checkboxes, and input Þelds.

To add a form element to a Web page:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Position the insertion point where you want the form element to 
appear. Do this by placing the cursor over the desired insertion 
point and clicking the mouse button once.

3 Choose Form Item from the Insert menu. 
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A list of form elements displays. You can also select Toolbars > Form 
Tools from the View menu to display the Form Tools toolbar:

4 Select the desired form element, or click its button in the toolbar.

When you insert a form element, Visual Page inserts the required 
<FORM> tag, along with the form element. This automatically creates 
the structure for a form.

Insert 
check-
box

Insert 
single-
line text 
box

Insert 
drop-
down 
list 

Insert 
radio 
button

Insert 
multi-
line 
text 

Insert 
list 
box

Insert 
submit 
button

Insert 
reset 
button
7-10



Creating forms
Using CGI

CGI scripts and applications pass information from your forms to your Web 
server. CGI scripts can be written in any computer or scripting language Ñ 
some of the more common languages used for CGI scripting include Perl, 
C and C++.

In most cases, youÕll want to use an existing CGI script or application. You 
can obtain CGI scripts and applications either from your System 
Administrator, or from a number of shareware and freeware CGI script 
archives on the Internet, including the following:

http://www.cis.ufl.edu/perl/

http://www.seas.upenn.edu/~mengwong/perlhtml.html

For further information, Web sites with information on CGI include: The 
General CGI Web site at http://www.selah.net/cgi.html, and the 
Perl archive at http://www.perl.com/perl/.

To access an existing CGI item on your local hard drive:

1 Choose Properties>Form from the Edit menu. 

The Form Properties dialog box displays, as shown below:

2 Enter the path and name of your CGI script or application in the 
Action Þeld.

3 Select the type of method your CGI item uses: post or get. The get 
method sends the user's information as part of the URL, while the 
post method sends it as a separate data stream.

4 Click OK. 

Visual Page inserts the proper HTML codes for your Web page to 
interact with your designated CGI item.
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Inserting multiple forms

Visual Page allows you to have multiple forms within a single Web page. 

To insert multiple forms:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Place the cursor where you want a new form to be inserted.

3 Choose Form Item from the Insert menu. 

A pop-up menu appears.

4 Choose Extra Form. The Form Properties dialog box displays.

5 Enter the path and name of your CGI item in the Action Þeld.

6 Select the type of method your CGI item uses: post or get.

7 Click OK.

The Form icon appears, indicating the extra form.

What’s next
In the next chapter, we examine Visual PageÕs Web site maintenance 
features, including working with projects, publishing your Web site, 
maintaining your Web site, and Þle transmission calculation, and folder 
mapping.
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Creating and managing 
Web sites

In order for people to have access to your Web-based Þles (Web pages, 
GIF graphics, plugins, and so on), you need to put them on a Web server. 
Visual Page has several features to assist you in publishing your Web Þles 
onto a Web server, such as an upload/download interface, Web site 
maintenance features, and Þle transmission calculator. This chapter 
explores these features in depth, and shows how you can use these 
features as part of your strategy for Web site management.

You can work in a project-based setting in addition to working on 
individual Þles. When you work in a project-based environment, you 
create sites that can be managed globally instead of manually updating 
individual Þles.

Creating a Web site
Before you start creating a Web site, you need to identify a folder on your 
local hard drive where youÕll store the contents of your Web site Ñ pages, 
graphics, and so on. This folder is your local Web site, also represented as 
a project. Visual Page creates a project Þle in your project. This project Þle 
keeps track of all your Þles within your local Web site, which the Project 
Manager will need to maintain your published site.

You open your project in Visual Page using the Project Manager. Visual 
PageÕs Project Manager window provides easy access to all of the Þles that 
will make up your Web site. 

The Project Manager is also a useful feature in the maintenance of the Web 
Þles that make up your Web site, as it allows you to view (and open) all of 
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the Web pages and graphics for your site. Using the Project Manager, you 
can rename, delete, and drag and drop Þles into any open Web page.

Understanding projects

A project is the starting point for every Web site that you create with Visual 
Page. The Project Manager shows each item in a project and its relationship 
to other items within the same project.

The project file and the project folder

The project folder contains a set of Þles, such as HTML documents, style 
sheets, image Þles, and CGI scripts that make up a Web site. 

The central element of the project folder is the project Þle. The project Þle 
contains all information necessary for management of the project, including 
locations of other related Þles, links, external style sheets, and other 
information such as browser data for viewing hierarchical relationships.

Projects speed development by updating all related Þles instead of opening 
each Þle and manually updating it. You can change relationships between 
documents and images visually rather than opening source code and 
possibly making mistakes and ÒorphaningÓ Þles.

Note: When you edit a Web page that is part of a project, the project Þle is 
updated even if the project is not open.
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The Project toolbar

The Project toolbar is the command center of the Project Manager.

Working with projects
This section describes how to:

n Create a project

n Open existing projects

n Working with Þles in a project

n Finding and replacing

n Checking spelling

Creating a project

You use the New Project Wizard each time you want to create a new site 
from scratch, or maintain an existing one.

The New Project Wizard will ask where on your local computer where you 
want to create a directory. Then, you need to supply the name of the main 
homepage, and FTP server information. You can modify this server 
information within the open project.

Add new 
page to 
project

Add new, 
untitled 
folder to 
project

Add files 
to 
project

Delete 
file, 
folder, or 
object

Rename 
file, 
folder, or 
object

Global 
find and 
replace

Global 
spell 
check

Download 
items 
from 
server

Upload 
items to 
server

Publish 
project to 
Web 
server

Abort 
operation

Refresh 
Project 
window

Project 
options
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To create a new project:

1 If you havenÕt done so, start Visual Page.

2 From the Visual Page toolbar, click the Create New Site icon. 

The Project Wizard opens.

3 Provide all the necessary information for the New Project Wizard 
to create Project Þle.

When you Þnish with the Project Wizard, the Project Manager 
window opens.

Opening existing projects

You can open previously saved Visual Page projects and continue 
working on them at anytime, even with another project open.

To open an existing project:

1 From the Project Þle menu, select Open Site Project. The Open 
Project dialog box displays.

2 Navigate to the desired project Þle and double-click it.

3 The project opens.

Once your local Web site is complete, you can publish your project to your 
Web server Ñ this allows other people to access your site via the Web. The 

Root level of 
project 
folder

Contents of 
folder 

Window tabs
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version of your site that is accessible via the Web is called your remote 
Web site.

You can also use the Project Manager window to view links and anchors. 
For more information, ÒInserting and displaying anchorsÓ on page 4-3.

Opening Web files within a project

A Web Þle can be a Web page, an image, or a Web multimedia Þle. To 
open a particular Web Þle in Visual Page, you can navigate to the Þle 
within Visual Page through the Project Manager, or you can drag the Þle 
icon from Windows Explorer into the Visual Page environment. For 
information on working with Web Þles, see Chapter 2, ÒCreating Web 
pages.Ó

To open a file within a project:

1 Open the project containing the Web page you want to work with.

2 Navigate to the Web page and double-click it.

The Web page opens in the Visual Page editor.

Creating new Web pages in a project

You can create a new page at anytime and it will automatically be added to 
your active project. The new Web page resides in whatever folder is open 
at the time.

To add a new page to a project:

1 Make the project window for that project active.

2 From the Project Manager toolbar, click the New Page icon.

A new, untitled page is added to the Project window, with all set 
preferences applied to it.

3 Double-click the new Þle to open it in the Visual Page editor.

Checking spelling in a project

When you start the Spell Checker from the project menu, the Spell Checker 
checks the spelling of all the Web pages in that project. When the Spell 
Checker reaches the end of a page, it will open the next one and locate the 
Þrst word it suspects as being incorrect.
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When you start the Spell Checker from the main toolbar, the Spell Checker 
checks whatever window is active. If itÕs an open Web page, it checks only 
that page. If itÕs a project window, it does a global check of the entire 
project.

For information on using the Spell Checker, see ÒUsing the Spell CheckerÓ 
on page 3-34.

Finding and Replacing

The global Þnd and replace feature of the Project Manager provides a 
powerful means of locating and replacing words throughout your project.

You can also use the Find/Replace feature on a single document.

To find and replace text in a single Web page:

1 Open or click on the Web page that you want to search.

2 Select Find/Replace from the Edit menu.

The Find/Replace window opens:

3 Enter or select search criteria:

Criteria Description

Match whole words only The Find/Replace editor search on the basis 
of  whole words only. For example, a search 
for ÒstreamÓ does not Þnd the word 
ÒstreamsÓ.

Match case The Find/Replace editor performs operation with 
respect to case

Find Performs the search and/or replace

Cancel Cancels the operation
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4 Select a function to continue:

To find and replace text throughout a project:

1 Click on the Find and Replace icon on the Project window toolbar.

2 Type your search criteria.

3 Click Find to perform the search.

The Project Manager scans all Þles in a project. When there is an 
occurrence of the word or words, the Project Manager opens the Þrst 
page containing the Þrst occurrence.

4 Select a function to continue, as described in the previous section.

When the Find/Replace feature has reached the last occurrence in a 
page, pressing F3 opens the next Web page and selects the Þrst 
occurrence of the search criteria.

Adding and removing files and folders

You can add Þles to a project, even if they are in different folders or 
directories within your project folder. 

When you remove a page or Þle from a project, the Project Manager 
updates all related links throughout the project. 

Replace Replaces the current selection only with the 
replacement string

Replace All Replaces all occurrences of  the current selection 
with the replacement string

Function Description

Find Next (F3) Moves to the next occurrence of  the search 
string.

Find Previous (Shift+F3) Moves to the previous occurrence of  the 
search string.

Replace and Find Next (under 
Edit menu)

Replaces the immediate occurrence and 
moves to the next occurrence.

Criteria Description
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Adding files to a project

You can add .html, .class (java files), CGI scripts, and many 
kinds of multimedia Þles to a project. When you add HTML and CSS Þles, 
the Project Manager automatically adds all other Þles referenced by them.

Remember that you should store all the Þles of a given project in a separate 
folder dedicated to that project, and use folders to organize your project, 
such as putting images into its own folder. Doing so will make deploying 
your Web site much easier.

To add files to a project:

1 From the Project Manager toolbar, click the Add Files icon.

The Add Files dialog box opens.

2 Change the Files of Type information if necessary.

3 Navigate to the target Þle and double-click it.

The Þle is added to the current project.

Adding folders to a project

You can create news folders in a project by using the Project Manager 
toolbar.

To add a new, untitled folder to your project:

1 Click the New Folder icon in the current project window.

A new, untitled folder appears.

2 Name your folder by typing in the box next to the Folder icon.

Note: Folders are added automatically to a project if a Þle within them is 
added to the project.

Removing files and folders from a project

When you delete a Þle from your project, you can delete only the 
references to it, or delete the Þle. When you delete only the references to 
it, the Project Manager automatically removes any references to it in all the 
Þles in that project. It does not delete the Þle.

When you delete the Þle, Visual Page deletes all references to that deleted 
Þle throughout your project.
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To delete a file or folder from a project:

1 Select the Þle or folder you want to delete.

2 Press the Delete icon on the Project window toolbar or press the 
Delete key.

You will be prompted if you want to delete the Þle from your 
computer as well.

Saving and renaming files in a project

Generally, the Visual Page Project Manager updates and saves your project 
Þle information as you work, but you can save Þles individually, or all of 
the open Þles in your project.

To save one file of a project:

You can save a Þle within the project separately from other Þles in a 
project.

1 Open the Þle in the Visual Page Editor.

2 From the File menu, choose Save.

The Save menu item is enabled only if there are changes to save.

To save all the open files in a project:

n From the File menu, select Save All.

To delete a project file:

1 If Visual Page is running, make sure that the Project window for the 
project is closed.

You cannot delete Þles while it is in use.

2 From the Windows operating system, delete the project Þle.

To rename a file or folder of a project:

1 Click on the Þle or folder you want to rename in the Project 
window.

2 Click the Rename icon on the Project window toolbar.

3 Type the new name for the Þle or folder.

4 Click the Þle or folder to accept the new name.
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Closing a project

When you close a project, only the project window closes and Visual Page 
remains open.

To close the active project:

n From the File menu, choose Close while the Project window is 
active.

All project changes are saved automatically. Visual Page remains open 
so you can work on other projects.

To close all projects and exit Visual Page:

n From the File menu, choose Exit.

All project changes are saved automatically. The project and Visual Page 
windows close.

Inserting links in a project

One of the easiest ways to create a link in Visual Page is to use the Project 
window as a place to drag Web pages and anchors from. For information 
on setting up your Project window, see ÒUnderstanding projectsÓ on page 
8-2.

To create a link with the Project window:

1 If youÕre not in Edit mode, switch to this mode by clicking the Edit 
Page toolbar button. 

2 Open the Project window for your project by selecting Open 
Project from the Project menu.

3 Open the Web page in which you are going to place a link.

4 To select a portion of your text, click and drag over the desired 
area. To select a graphic, click anywhere on it once. 

5 Drag the icon for the Web page (that you want to link to) from the 
Project window to the selection in your Web page. 

Visual Page creates the link.
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Displaying links and anchors

You can use the Project window to display all of the links and anchors in 
your project folder. The Project window can be useful, for example, in 
keeping track of your anchors across a large Web site. 

To display all of the links and anchors within your project:

1 Open a Project window by selecting Open Project from the Project 
menu. 

2 Within the Links view of the Project window, locate a Web page 
that contains anchors, and click the + (plus sign) next to it. A Web 
pageÕs anchors is listed, with an anchor icon next to it, as shown 
below:

3 Double-click on the anchor for the Web page whose anchors you 
want to display.

To display a dialog box listing the anchors in a Web page:

1 Select the text you wish to put an anchor.

2 Right-click over the selected text. 

A menu appears.

3 Choose Link To. 

The Link dialog box appears.

4 From the anchor drop-down menu, select an anchor. 

The Project Manager automatically links the selection to the chosen 
anchor.

Publishing your project
In order for the world to have access your Web site, you must publish it to 
a Web server. First, you set your siteÕs options to assign CSS Þles, setup 
folder mappings, and conÞgure or change the settings for your network 
connection. Then, you make the connection to your Web server and 
publish your project.
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Setting site options

You set and change site options by using the Project Manager. You can 
assign a default style sheet, create or change folder mappings, and change 
FTP server information.

To change site options:

1 Open the project you want to publish.

2 Click the Project Options icon from the Project Window toolbar.

The Project Options window opens.

Linking and unlinking an external default style sheet to your 
Web site

You can create or remove an external default style sheet link at any time to 
your Web site through the Project Options dialog box. For more 
information on working with style sheets, see ÒFormatting tags and pages 
with style sheetsÓ on page 3-12.

To link an external default style sheet to your Web site:

1 Click the Project Options icon in the Project window.

The Project Options dialog box appears.

2 Click the CSS File tab.

3 Click the checkbox to navigate to the style sheet.

4 Double-click the style sheet in the Open File dialog box.
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The path and style sheet name appear in the text box.

To unlink an external default style sheet from your Web site:

1 Click the Project Options icon in the Project window.

The Project Options dialog box appears.

2 Click the CSS File tab.

3 Clear the checkbox.

The path and name of the style sheet is cleared.

Note: Only the link is removed; the style sheet is not deleted from your 
project.

Mapping folders

Note: If you are not very familiar with the differences between remote and 
local Þle mapping, do not use this feature. Misuse of this feature may result 
in some or all of your links breaking.

Visual Page lets you map local folders to their remote counterparts. This 
feature allows you to replace all references to a local folder on your hard 
drive with a remote (Web server-based) folder or a URL. This feature can 
save you hours of changing references to local folders to their remote 
folder or URL counterparts. For example, if you have eight Web sites, all of 
which use the remote URL http://www.mysite.com/graphics to 
store graphics, you can map the URL to the respective graphics folders for 
your local sites, without having to change the links to the URL for all eight 
Web sites.

Be sure to map your folders between your local and remote sites before 
you start creating pages Ñ this will prevent you from having to remap the 
folders if you decide to change the folder's names midway through the 
process.
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To map your local and remote folders:

1 Click the Project Options icon in the Project window.

The Project Options dialog box appears.

2 Select the Folder Mappings tab, as shown below.

3 Place the cursor in the Þrst empty cell of the Remote column.

4 Type in the full pathname or URL of the remote folder.

5 Press the Tab key.

6 Type in the name of the local folder you want to map to the 
remote folder or URL.

You can also select a local folder by clicking the Local Folder button, 
navigating to the folder you want to map, then pressing the button at 
the bottom of the Select Folder dialog box.

7 Repeat steps 3-6 for any additional folders that you want to map.

8 If you want to override the speciÞed local and remote folders, 
click Cancel; otherwise, click OK.

Note: The contents of mapped folders are never published to the Web 
server.

Configuring a network connection

Whenever you create a new Web site with the Project Manager, you 
initially conÞgure network connections through the Project Wizard, and 
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change them in the project. The Web server that you conÞgure for each 
Visual Page Web site is local only to that Web site.

Visual Page allows you to change the default project options for your Web 
server, including server name, password, directory, and user ID through 
the Publish feature. 

To configure your server settings for your Web site:

1 From the Visual Page toolbar, click the New Project icon. The 
Project Wizard appears.

2 Use the Project Wizard to setup your Web site.

When you see the Server Information page, provide the necessary 
information:
n Host: Enter the host name of your Web server in the Default 

FTP host Þeld (for example, ftp.symantec.com)
n Directory: If you are going to a subdirectory within your home 

directory, enter it in the Default FTP directory Þeld. In most 
cases, the server defaults to your home directory as your 
destination ÑÊif this is the case, you can leave this Þeld blank.

n User name: If the site you're accessing requires a user name, 
enter the user name or ID for your account in the Default user 
name Þeld (for example, JQPublic)

n Password: If the site you're accessing requires a password, 
enter the password for your account in the Default password 
Þeld.

3 Click Finish to close the Project Wizard

Note: Most Web and FTP servers use operating systems that are case 
sensitive. Contact your ISP for your correct login, password, and directory 
information.

If you change the password on your Web server, you must change it in 
Visual Page. Contact your ISP or Systems Administrator for assistance with 
changing your server password.

To change your server settings:

1 Open your Web site through the Project Manager.

2 Click on the Project Options icon. 

The Project Options window opens.
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3 Click the Server tab:

4 Change the information as necessary. See ÒConÞguring a network 
connectionÓ on page 8-14 for more information

5 Click OK to close the Project Options dialog box.

Note: Your password is not displayed.

Connecting to your Web server

Visual Page uses File Transfer Protocol (FTP) to communicate with your 
Web server. If you have a direct Internet connection, then Visual Page 
connects to your Web server as needed. If you are using Windows 95 or 
NT Dialup Networking, establish the connection to your Web server before 
using any operation that requires a connection, such as opening the Server 
tab, publishing, or downloading.

If you are using Visual Page over an intranet, there are other ways to 
publish your Web site if FTP is unavailable. For example, if you are on a 
Microsoft network, one way is to drag and drop your entire project folder 
to the server that hosts your site. To let the world see your Web site, you 
need to publish your project. The Visual Page Project Manager publishes 
two ways:

n By uploading your project

n By uploading individual Þles

You can change 
server information, 
such as your 
password, at any 
time by clicking the 
Server Info tab of 
the Project 
Options dialog box.
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Publishing a project

Visual Page publishes your project to your Web server with a click of a 
button. The Project Manager replaces the Þles on your Web server with 
those that have been modiÞed in your project.

To publish your project to your Web site:

1 Click the Files tab of the Project Manager.

2 Select the root folder of your project.

3 Click the Publish icon. If you are not connected to your Web 
server, the Windows 95 or Windows NT Dialup Networking opens 
and prompts you to initiate the connection.

Visual Page publishes your project.

Uploading individual files to your Web server

Occasionally, you may want to upload a Þle or two that may or may not be 
part of your Web site.

To upload selected files to your Web server:

1 In the Project Manager, select the Þles that you want to upload. 
You can use standard Windows mouse-key combinations to select 
Þles.

2 Click the Upload icon in the toolbar of the Project window.

3 The ConÞrm/Replace dialog box appears, if needed.

Note: When you publish an entire project, the Project Manager silently 
overwrites existing Þles. When you are uploading Þles (not publishing) 
you will be prompted to replace exisisting Þles.

Downloading files and folders from your Web server

You may occasionally need to download Þles from your Web site, for 
example, if you are archiving an older version of your site, or have 
accidentally deleted a Þle off your local hard drive.

You can also import a remote site and then create a new project for it. 
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To download files and folders from a Web server:

1 Click the Server tab in the Project window. If you are not 
connected to your Web server, the Windows 95 or Windows NT 
Dialup Networking dialer opens and prompts you to initiate the 
connection.

2 Select the name of the Þles or folders that you want to download. 
If you are selecting multiple Þles, be sure to select them in the Þle 
list on the right side of the Servers window.

3 Click the Download button in the Project window toolbar. The 
ConÞrm/Replace dialog box appears, if needed.

Visual Page automatically puts Þles in a corresponding folder under 
your project folder, and creates the folder if necessary. The directory 
structure of the remote folder is preserved in the new local folder.

Disconnecting from the Web

Once you Þnish publishing or downloading your Þles, you may want to 
disconnect from your Web server, or from the Internet if you are using 
Dialup Networking. Otherwise, Visual Page closes your FTP connection if 
you are on a network.

To disconnect from your Web server using Dialup Networking:

n Close the connection from the Windows 95 or Windows NT Dialup 
Networking.
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Maintaining your Web site
Visual Page includes several features you can use to maintain the Þles on 
your Web site and to perform other related tasks.

You need to have a project open or create a project to use this 
functionality. You maintain your remote Web site by clicking on the Server 
tab of the Project Manager.

Deleting remote files or folders

Visual Page supports the deletion of folders and Þles from your local and 
remote project folders, without the use of third party FTP software. 

When you delete a Þle from the server, it does not delete it from the local 
project. The deleted Þle will be restored to the Web server the next time 
you publish your project if you did not delete the Þle from your project.

If you delete items from your project while in the Files tab, you will be 
prompted to also delete the Þle from your computer. However, the Þle will 
not be deleted from the server. Also, if you delete a Þle from the server, it 
is not deleted from your project or computer.

Click the 
Server tab to 
work with 
your remote 
site
8-19



Chapter 8: Creating and managing Web sites
To delete a file or folder from your server:

1 Select the Server tab in the Project window.

2 Select the name of the Þle or folder you want to delete.

3 Click the Delete icon. 

You will be prompted to delete the Þle or folder.

The Þle or folder is deleted from the server.

Renaming remote files

Visual Page supports the renaming of Þles directly on your Web server. 

To rename a file on your Web server:

1 Open the project for your Web site and click the Server tab.

2 Select the name of the Þle you want to rename.

3 Click the Rename button.

The name of the Þle is selected.

4 Type in the new name for your Þle and click once to make the 
change permanent.

Note: Visual Page doesnÕt support the renaming of remote folders because 
FTP does not.

Creating a remote folder

Visual Page supports the creation of folders directly on your Web server. 

To create a new folder on your Web server:

1 Open the Project window.

2 Click the Server tab in the Project window.

3 Press the New Folder icon.

4 Type in the new name in the New Remote Folder Þeld.

5 Click OK to accept the folder name and close the dialog box.

The new folder is created within the folder displayed at the top of the 
left server window.
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Repairing links

You view the links between pages and objects by clicking the Links tab in 
the Project Manager. The Project Manager provides a visual feature to let 
you modify links. You can also open any associated page or object in the 
Links tab by double-clicking the item.

You can also expand and collapse Þles to show or hide link relationships.

Visual Page uses colored lines to represent the status of each link. A red 
arrow indicates the links that are not valid. Blue arrows indicate that the 
Þles or objects are linked correctly.

When you click the Links tab, the Links toolbar appears:

External 
links

Internal 
links

Image 
links

Anchors

Email 
links

Invalid 
links

Missing 
links
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Viewing links

When you click on the Links icon, you can view the relationships of all 
links in a project.

To view links in a project:

1 Click the Links tab in the Project window.

2 Click on a Web page or object in the left window of the Project 
window.

Links toolbar icon Shows or hides:

External links External links within this site

Internal links Internal links within this site

Image links Links to images

Anchors Anchors

Email links E-mail links

Invalid links Invalid (red) links

Missing links Missing (red) links
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Maintaining your Web site
The Þle or object is represented in the links window with its links to 
and from it:

Repairing links

When you click the Status tab of the Project Manager, you can repair links 
by double-clicking the Þle that is marked as having a bad link. 

Double-
click on an 
invalid link 
to open the 
Repair Link 
window

The red 
lines 
indicate the 
sources of 
the broken 
links
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Chapter 8: Creating and managing Web sites
To repair a bad link:

1 Click the Status tab of the Project Manager.

2 Double-click a Þle marked as having a bad link.

The Repair Link window opens:

3 Select the correct Þle or object to link to by clicking Browse to 
navigate to the Þle or object, or type in the path in the To box.

4 Click OK to make the correction and close the Repair Link 
window.

The link is repaired throughout the entire project.
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Calculating file transmission times

Visual Page provides tools for determining the amount of time that it takes 
for a Þle to transfer, given the Þle's content and the connection speed. 
These approximate transmission times are for how long a Web browser 
(using HTTP) takes to download and display the Web page.

To determine the download time for a file:

1 Open the Þle for which you want to determine the transmission 
time for.

2 From the File menu, choose Download Statistics. The Download 
Statistics window displays.

The Download Statistics window consists of the following elements:
n The Total Document bar displays the transmission time for the 

Þle in the active window, at the baud rate indicated in the 
Modem Speed pop-up menu.

n The Selected Object bar displays the transmission time for the 
selected object (such as a GIF image), at the baud rate indicated 
in the Modem Speed pop-up menu. If no object is selected, the 
displayed transmission time is set to 0 seconds.

n The Selected Frame bar displays the transmission time for the 
selected frame set, at the baud rate indicated in the Modem 
Speed pop-up menu. If no frame is selected, this bar doesnÕt 
display.

n The calculated transmission times are displayed in the right-
hand side of the window.

3 To calculate a time for a different baud rate, select the new rate 
from the Modem Speed pop-up menu. The recalculated time 
displays in the right-hand side of the window.
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Chapter 8: Creating and managing Web sites
What’s next
A glossary of commonly used terms follows this chapter. 

Good luck with your Web projects, and enjoy using Visual Page!
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G L O S S A R Y

anchor A type of link , used to mark speciÞc locations within a Web 
page.

applet A Java program that is designed to run only on a Web page.

base URL The base URL for a Web page sets the URL upon which all 
links in the Web page are based.

cell A cell is a separate entry area within a table. 

CGI An acronym for Common Gateway Interface. CGI is the 
protocol that handles the information that a user enters into a 
form .

client The user of a network; alternately, a local application that 
connects to a remote server.

edit mode The edit mode is used to create and modify Web-based 
content. 

forms Forms let users pass information (such as their name and 
address) from their browser to a Web server. Forms commonly 
interface with Common Gateway Interface (CGI) applications.

frame The element within a frame set that contains a HTML Þle.

frame set A type of Web page, consisting of two or more independent 
sections (frames) that each display a HTML  Þle. 

FTP An acronym for File Transfer Protocol. The File Transfer 
Protocol is the common command set used to upload and 
download Þles from Web sites. Visual Page uses FTP 
extensively as part of its set of Web publishing features.

GIF An acronym for Graphic Interchange Format. Developed by 
CompuServe, the Graphic Interchange Format is a common 
cross-platform, WWW  format for graphics. Another common 
WWW graphic format is the JPEG format.

HTML An acronym for HyperText Markup Language. It is used to 
ÒmarkupÓ or identify which parts of a .html or .htm text Þle 
to display in which format.
1



Glossary
hypertext Computer documents that contain links embedded in text or 
graphics. Hypertext links display related information when 
you click on them.

image map A graphic with linkable regions within it. There are two types 
of image maps: client side, which contain their coordinate 
information within the graphic Þle, and server side, which 
contains its coordinate information in a separate .map Þle on 
the server.

insertion point Any text you enter appears at the insertion point, which is 
indicated by the text cursor. 

interlaced images Interlaced images download as Þrst a general outline of the 
image, and then as more image data is received by the 
browser, the details of the image come into view. 

Internet The largest computer network in the world. Originally 
designed for military use, the Internet expanded into academic 
usage, and then into the public arena.

Intranet A subsection of the Internet , contained within a corporate 
network.

Java An object-oriented programming language developed by Sun 
Microsystems. Java is device independent, allowing compiled 
Java programs and applets to run on any computer.

JavaScript A scripting language developed by Netscape Communications.

JPEG A acronym for Joint Photographic Experts Group, the creators 
of the JPEG Þle format. The JPEG format was developed for 
high-quality photographs and supports 24-bit images. Another 
common WWW  graphic format is the GIF  format.

layer Section of a Web page acting independently from the rest of 
the Web page containing it.

link Web page-based text or graphics that respond to a mouse click 
by displaying the media that theyÕre connected to, such as a 
Web page. 

local Web site A collection of Web pages that are installed on your local 
computer, also known as a project in Visual Page.
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main editing 
window

The main editing window serves as the visual editor for Visual 
Page. This is where youÕll do most of your Web page 
formatting and editing

network protocol Aset of predeÞned commands to process information over a 
computer network.

Project window The Visual Page Project window provides easy access to all of 
the Þles that will make up your Web site.

plugins An accessory to a Web browser, commonly used to extend the 
browserÕs feature range. 

preview mode The preview mode is a way to view documents as they appear 
in a userÕs browser.

project The collection of Þles that will be published to the Web server. 
Also known as local Web site.

remote Web site The version of your site that is accessible via the Web is called 
your remote Web site.

server A computer that is conÞgured (via software and hardware) for 
the storage and handling of Þles.

source editor The source editor is used to edit the HTML  source code of a 
Web page.

style sheet A collection of style deÞnitions that are applied within a Web 
page or from an external one.

table A method of presenting information in a uniform format (rows 
and columns). 

target The frame or Web page window that a linked Þle displays in. 

text cursor The text cursor appears as blinking vertical line, and indicates 
the insertion point for any text you enter.

URL An acronym for Uniform Resource Locator. A speciÞc address 
used by Web browsing software to locate and access 
information on the Web.

Web browser The local application you use to connect to a Web server. It 
interprets and displays HTML-encoded documents (Web 
pages) graphically.
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Glossary
Web page A text document which is encoded in HTML , displayed by a 
browser application, and accessible from remote sites via the 
Web.

Web server A type of server dedicated to storing, transmitting, and 
receiving Web pages and Web-related Þles, such as GIF  and 
JPEG graphics.

Web site A collection of Þles that are linked to a central Web page, 
made available via the Web.

World Wide Web The part of the Internet  that contains Web pages. The World 
Wide Web is commonly referred to either by its acronym 
ÒWWWÓ, or simply as the Web.
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I  N  D  E  X  
A
adding, 3-16
Aligning layers, 5-26

left edges, 5-27
aligning layers

align to grid, 5-28
bottom edges, 5-28
right edges, 5-27
top edges, 5-27

anchors, 1-8, 1-10Ð1-11
definition, 1-10, G-1
displaying, 4-3, 8-11
displaying in project, 8-11
displaying in Project window, 8-11
listing, 8-11

applets, 1-12Ð1-13, 7-4Ð7-7
definition, 1-12, G-1
inserting, 7-4
preferences, 7-5Ð7-6

B
Background attributes tab

description, 3-26
base, 6-13
borderless frames, 6-8

C
cascading style sheets, 1-12
CGI, 1-13, 7-11

definition, 1-13, G-1
character formats

using, 3-3
characters

changing font size of, 3-9
formatting, 3-7Ð3-9
spelling, 3-34
styles, 3-7Ð3-9

client, G-1
Common Gateway Interface. See CGI
Configuring a network connection, 8-14
containers, 5-19

deleting, 5-19
inserting, 5-19

Creating a Web site, 8-1
Creating layers, 5-18

D
definition, 1-8
Deleting, 6-16
Deleting layers, 5-29
documentation

online help, 1-4
Visual Page tour, 1-4

E
edit mode, 2-16
editing area, 2-5
entries, 3-35
External style sheets, 3-13

adding globally, see ÒLinking and unlinking an 
external default style sheet to your Web siteÓ on 
page 8-16, 3-18

adding to Page Style Sheet window, 3-16
creating, 3-13
creating based on a template, 3-16
modifying, 3-16
opening an existing external style sheet, 3-15
removing, 3-16
Style Attributes window, 3-14
style sheet editor, 3-13

F
file, 6-13
finding and replacing, 8-6

globally, 8-7
locally, 8-6

Flowing, 5-5
font groups

creating, 3-10
selecting, 3-11
working with, 3-10

font size, 3-9
Form Tools toolbar, 7-10
formatting text

paragraph styles, 3-3
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forms, 1-13, 7-9Ð7-12
definition, 1-13
Forms Palette, 7-9
inserting form elements, 7-9Ð7-10
inserting multiple, 7-11Ð7-12

frame layouts, 6-1Ð6-5
creating, 6-3
definition, G-1
No Frames window, 6-11
saving, 6-3

frames
changing Web page in, 6-6
definition, G-1
displaying Web page in own window, 6-7
removing, 6-10
resizing, 6-9Ð6-10
saving, 6-4Ð6-5
setting attributes, 6-7
splitting, 6-10

FTP
definition, G-1

G
GIF, 5-2, G-1
graphics, 5-1Ð5-30

aligning, 5-4Ð5-5
copying and pasting, 5-4
file types, 5-2
flowing text around, 5-5
image maps, 5-13Ð5-16
inserting, 5-2Ð5-4
preferences, 5-5Ð5-8
tiled backgrounds, 5-9Ð5-11
transparent, 5-8Ð5-9

H
home page, 1-6
HTML, 1-1, 1-7Ð1-8, 3-32Ð3-33, G-1
http, 1-7
Hypertext, 1-8
hypertext, G-2

definition, 1-8

I
image map

definition, G-2

image maps, 5-13Ð5-16
inline styles

modifying with Style Attributes window, 3-21
overview, 3-20

Inline Styles window
applying styles from Show Styles window, 3-22
opening, 3-22
Paragraph tab, 3-21

Inserting, 4-3
Internet, G-2
Intranet, G-2

J
Java, 1-12Ð1-13

applets, 7-4Ð7-7
console, 7-6Ð7-7
definition, G-2

JavaScript, 1-13, 7-7Ð7-8
adding to a Web page, 7-7Ð7-8
calling a JavaScript file, 7-8Ð7-9
creating a JavaScript file, 7-7
definition, 1-13, G-2

JPEG, 5-2, G-2

L
launching Visual Page, 2-1
Layer toolbar, 5-17
Layers, 1-12
layers

creating, 5-18
deleting, 5-29
moving, 5-20
moving forward and backward, 5-22, 5-24
moving to front or back, 5-22
resizing, 5-26
spacing evenly, 5-29

line breaks, 3-32
lines, 5-12Ð5-13
Link To

using, 8-11
Link To field, 2-5

using, 4-2
links, 1-9Ð1-10

creating, 4-1Ð4-2
definition, 1-9, G-2
email address in, 4-7Ð4-8
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Link To Field, 2-5
repairing, 8-21
viewing, 8-21

Links toolbar, 8-21
local style sheets

creating, 3-19
editing, 3-20
HTML tags associated with, 3-19
removing, 3-20
working with, 3-18

local Web site
definition, G-2

M
main editing window, 2-7
Mapping folders, 8-13

P
paragraph breaks, 3-32
paragraph inline style

creating, 3-22
paragraph style

applying, 3-4
paragraph styles

supported, 3-5
paragraphs

formatting, 3-32Ð3-33
Personal Dictionary, 3-35
plugins, 7-1Ð7-4

definition, G-3
inserting, 7-1Ð7-2
preferences, 7-3Ð7-4

preferences, 2-7
applets, 7-5Ð7-6
global, 2-7
graphics, 5-5
images, 5-5
page defaults, 2-9
plugins, 7-3Ð7-4
setting, 2-7
tables, 6-20Ð6-24
Web pages, 2-11Ð2-12

preview mode, 2-16
printing, 2-18Ð2-19
projects

adding files, 8-8

adding files and folders, 8-7
closing, 8-10
creating, 8-3
creating new Web pages, 8-5
opening, 8-4
opening Web pages, 8-5
project file, 8-2
project folder, 8-2
publishing, 8-11
removing files and folders, 8-8
setting up, 8-2
unlinking an external default style sheet, 8-13
viewing links, 8-22

publishing, 1-5
unlinking an external default style sheet, 8-13

R
remote Web site, 8-4
removing, 3-16
Repairing links, 8-23
rules. See lines

S
server, G-3
server settings

changing, 8-14, 8-15
setting, 2-7
Show Styles window, 3-22
source editor, 2-17
spacing layers evenly, 5-28
Spell Checker

functions available, 3-35
starting, 3-34

Spell checker
using, 3-34

spelling
checking, 8-5
checking globally, 8-6
checking locally, 8-6

starting Visual Page, 2-1
Style Attributes window

description, 3-23
Style sheets, 1-12
styles

applying paragraph, 3-4
Symantec, 1-5
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symbols, 3-33Ð3-34
system requirements, 1-3

T
tables, 6-13Ð6-24

cells, 6-13, 6-19, 6-22Ð6-24
coloring, 6-18Ð6-20
creating, 6-13Ð6-14
deleting rows, 6-16
editing, 6-14Ð6-18
editing multiple cells, 6-14Ð6-15
inserting columns, 6-16
inserting rows, 6-15Ð6-16
preferences, 6-20Ð6-24
resizing, 6-18
spanning rows and columns, 6-17

tags, 1-7Ð1-8
target, 6-11

definition, G-3
text, 3-1Ð3-36

coloring, 2-10, 3-11, 6-18Ð6-20
copying and pasting, 3-3
dragging and dropping, 3-2
flowing around graphics, 5-5
inserting, 3-1Ð3-3

The, 6-16
tiled backgrounds, 5-9Ð5-11
toolbar, 2-3Ð2-5

buttons, 2-5
docking, 2-3
icons, 2-4

toolbars
Links, 8-21

U
Uniform Resource Locator. See URL
URL, 1-9

definition, 1-9, G-3

V
viewing links, 8-22
Visual Cafe, 7-7
Visual Page

exiting, 8-10
main editing window, 2-1
starting, 2-1

templates included with, 2-15Ð2-16

W
Web, 1-7
Web browser, 1-7

definition, G-3
Web pages

creating, 2-13Ð2-16
definition, 1-5, G-4
download times for, 8-25
opening, 2-1
preferences, 2-11Ð2-12
printing, 2-18Ð2-19
templates, 2-15Ð2-16

Web programming, 1-12Ð1-13, 7-4Ð7-12
Web servers

and CGI, 1-13
creating folders on, 8-20
definition, 1-8, G-4
deleting files from, 8-19Ð8-20

Web site, 1-5
Web sites

definition, 1-6, G-4
importing, 8-17

Web, the. See World Wide Web
World Wide Web

definition, G-4
WWW. See World Wide Web
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